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Bevezető 

Az Excel táblázatkezelő program és a Micrsosoft Office, irodai programcsomag 
része. A táblázatkezelő program feladata táblázatosan elrendezett adatok hatékony és 
látványos kezelése. Általában költségvetések, előrejelzések elkészítésére, egyéb pénzügyi 
és matematikai feladatok megoldására alkalmazzuk. A táblázatkezelők rendszerint 
rendelkeznek adatbázis-kezelő funkciókkal és diagramok is létrehozhatók velük. Ezek a 
programok az adatértékeket cellákba rendezve tartalmazzák, a cellák tartalma közötti 
kapcsolatokat pedig megfelelő képletekkel fejezzük ki. 
 
Az Excel lehetőségei a az oktatásban 
 

Microsoft Excel programot az oktatásban a órarendkészítésre, hiányzások 
kiszámítása, átlagszámításra, különböző költségek kiszámítására és diagrammok 
készítése (pl. tanulmányi átlagból) tudjuk felhasználni. Hasznos segédeszköz lehet  a 
mérések, kísérletek és megfigyelések eredményeinek tárolásánál és az ezekkel történő 
műveletek elvégzésénél. A táblázatban található adatokból könnyen készíthetünk 
diagramokat is, amely a hatékonyabb szemléltetést és áttekintést tesz lehetővé. 

 A programot magyar nyelvre is lefordították, munkánkban az angol és a magyar 
kifejezéseket is feltüntettük (mivel a magyar szakszavak a számítástechnikában még nem 
terjedtek el eléggé). A mintatáblázatoknál kék színnel jelöltük a megnevezéseket, zölddel 
a bevitt adatokat és pirossal azokat a cellákat, amelyekbe a számítási műveletek 
eredménye fog kerülni. Hatásos, ha a saját táblázatok elkészítésénél a táblázat 
határolóvonalának a  meghatározásánál vastagabb vonalakat használunk, mint amilyenek 
a cellák körvonalai.  
 

Alapműveletek 
 
A szoftver futtatása 
 

A programot legegyszerűbben a Start menü All Programs > Microsoft Office > 
Microsoft Office Excel 2003 parancsának segítségével futtathatjuk. 
 
A programablak részei 
 

A program elindulásakor megjelenő képernyő közepén sorokból és oszlopokból 
álló rácsos elrendezésű táblázatot látunk, ahol az oszlopokat nagybetűk (A, B, C, D, AA), 
míg a sorokat egész számok (1, 2, 3, 4, ...) jelölik. A táblázat legkisebb eleme a Cella 
(Cell). A cella egy sor és oszlop metszéspontja, s rá úgy hivatkozhatunk, hogy először az 
oszlop nevét, majd a sor számát adjuk meg. A táblázat bal felső sarkában az A1-es cella 
található, mellette közvetlenül a B1-es cella van, míg az A1-es alatt az A2-es.  

Ezt a táblázatot Munkalapnak (Sheet) nevezzük. Az Excelben több munkalapon 
dolgozhatunk. Ezek közül egy mindig aktív. A munkalapokat a program Munka1 
(Sheet1), Munka2 (Sheet2)… módon jelöli. Ha kettőt kattintunk az egérrel a feliraton, 
átnevezhetjük azt, Enter-el nyugtázva a beírást.  
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Az egérmutatóval a lapfülre mutatva, az egér bal gombját lenyomva tartva, 
áthúzással módosíthatjuk a munkalapok sorrendjét. Jobb egérgombbal kattintva a 
lapfülön, helyi menü jelenik meg, ahol több lehetőség közül is választhatunk, új 
munkalapot szúrhatunk be, törölhetjük, átnevezhetjük, másolhatjuk a munkalapot, 
valamint meghatározhatjuk lapfül színét (fehér az alapbeállítás). 
 
1. kép 
Az Excel programablak részei 
 

 
 
Mentés 
 

A mentés hasonló módon történik, mint a Wordben. Amikor a mentésre 
kattintunk, az összes munkalapot, azaz a munkafüzetet mentjük el. Az így létrejött fájl, 
vagyis az Excel munkafüzet kiterjesztése - .xls.  
 
Fájltípusok 
 
 A 2003-as Excel legismertebb fájltípusai: xls (munkafüzet), xlt (sablon) és a htm 
(weblap). A 2007-es Excel ezeket a fájlokat xlsx és xltx kiterjesztéssel jeleníti meg. 
 
Olalbeállítás 
 

Szerkesztőléc 
Kijelölt cella 

Sorazonosító 

Oszlopazonosító 

Cella 

Aktív munkalap 
Munkalap füle 
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A Fájl  > Oldalbeállítás (File > Page) panelen határozhatjuk meg az oldal 
alapbeállításait, engedélyezhetünk a lapnak álló vagy fekvő tájolást, illetve beállíthatjuk a 
margókat. 

Gyakran előfordul, hogy a táblázatot egy oldalra szeretnénk kinyomtatni, a 
cellahatárok módosítása nélkül. Ilyen esetekben alkalmazzuk a Fájl  > Oldalbeállítás 
(File > Page Setup) Oldal (Page) fülén található Legyen az eredeti méret 
meghatározott %-a (Adjust to _% normal size) utasításokat, illetve a Legyen 
meghatározott oldal széles és meghatározott oldal magas (Fit to page(s) _ wide by _ 
toll). 

Az Élőfej és élőláb (Header/Footer) fül segítségével tudunk élőfejeket és 
élőlábakat létrehozni sablon szerint (a listáról választva), illetve tetszőlegeset az Egyéni 
(Custom) opciót választva, illetve az egyéni szöveget beírva. Az élőfejek és az élőlábak a 
nyomtatási képen. illetve a nyomtatásban láthatóak. 
 
2. kép 
Oldalbeállítás 
 

 
 
 
Kijelölés 
 

Az egyes cellák kijelölése bal egérklikkeléssel történik, összeföggő cellák 
kijelölése egér behúzással, az elkülönülő celláké pedig CTRL + egérklikkelés 
segítségével. A teljes munkalap kijelölés CTRL + A vagy a oszlop- és sorazonosítók 
metszésénél található négyzetre kattintva történik. 
 
FELADATOK: 
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1. Próbáljuk ki az egyes kijelölési módokat 
 
A szerkesztőléc 
 

Az oszlopazonosítók fölött a Szerkesztőléc található, aminek bal szélén az aktív 
cella címe, jobbra pedig a tartalma látható.  
 
 
3. kép 
A szerkesztőléc 
 

 

 
Adatbevitel 
 

Az Excel celláiba alapesetben szöveget vagy számot írhatunk. A beírt adatot az 
iránybillentyűkkel („nyíl” billentyűkkel) vagy az Enterrel nyugtázhatjuk. A “Delete” 
billentyű törli az aktív cella tartalmát. A cella tartalmát módosíthatjuk, ha kettőt 
kattintunk rá, vagy az F2-es funkcióbillentyűvel. Ha számot írunk be, legyen az egész 
vagy tizedes szám, az Excel a cellán belül jobbra igazítja. Ha szöveget viszünk be, akkor 
azt az Excel balra igazítja a cellán belül. 
 
Cellák beszúrása 
 
 Gyakran előfordulhat, hogy már elkészült táblázatban szeretnénk újabb sort vagy 
oszlopot beszúrni. Ezt megtehetjük a helyi menü Beszúrás (Insert) vagy a Beszúrás 
menü Sorok (Rows) vagy Oszlopok (Columns) pontjára mutatva. Miután a Beszúrás 
menüpontra mutattunk, egy panel jelenik meg, amelyen meghatározhatjuk, hogy a cellák 
merre tolódjanak el a beszúrás után. Itt tudjuk meghatározmi azt is, hogy sort vagy 
oszlopot kívánunk beszúrni. 
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4. kép 
A Cellák beszúrása parancs után megjelenő panel 
 

 

 

A cellák formázása 
 

Az adatbevitel után gyakran előfordulhat, hogy a beírt szöveg nem fér el a 
cellában, és a mellette lévő cella üres, akkor a szöveg "átcsúszik" következő cellába is. 
Ha ez a cella tartalmaz adatot, akkor a beírt szövegnek csak egy részét láthatjuk. 
Amennyiben az oszlopazonosítók (oszlopfejléc) valamely elválasztó vonalára vezetjük az 
egér mutatóját, és az egér bal gombját lenyomva tartva jobbra-balra mozgatjuk, a vonaltól 
balra eső oszlop szélességét módosíthatjuk. Hasonlóképpen módosíthatjuk a sorok 
magasságát is. 

A Formázás eszköztáron találjuk a Cellaegyesítés (Merge and Center) gombot. A 
Cellaegyesítés parancsot a következő ikon jeleníti meg: . Ezzel több kijelölt cellát 
egyesíthetünk. Az így kialakult terület elfoglalja az előzőleg kijelölt cellákat, amire 
ezután a bal felső cella cellacímével hivatkozhatunk, s a benne lévő adatok középre 
igazítva jelennek meg. A cellaegyesítést leggyakrabban a táblázatok nevének 
megadásakor használjuk. 

 
5. kép 
A Cellaegyesítés utasítás 

 

 
 
Összefüggő cellákat egérrel, illetve a Shift billentyűt lenyomva tartva, 

iránybillentyűkkel jelölhetjük ki. Kijelölhetünk nem összefüggő tartományokat is. 
Ilyenkor az első terület (vagy cella) kijelölése után a Ctrl billentyűt lenyomva kell 
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tartanunk. Az oszlop- vagy a sorazonosítókra kattintva egész sorokat és oszlopokat is 
kijelölhetünk. Az oszlop- és sorazonosítók találkozási pontjánál található szürke 
négyzetre klikkelve a teljes munkalapot kijelölhetjük. 

A Cellák formázása (Format Cells) utasítással az aktív cellát, vagy a kijelölt 
területet (tartományokat) tulajdonságait módosítjuk. A parancsot a jobb kattintás után 
találjuk meg a megjelenő helyi menüben.  
 
6. kép 
A cellák formázására szolgáló panel 
 

 
 

A Szám (Number) fülön meghatározhatjuk a cellában megtalálható szám 
megjelenítési módját (általános, szám, százalék, tört). A kategória kiválasztása után 
finomabb beállításokat eszközölhetünk. Kiválaszthatjuk a pénznemet, a tizedesek, 
számát, a dátumformátumot. A Minta (Sample) mezőben megtekinthetjük azt, hogy 
hogyan fog majd kinézni az a rész, amelyre alkalmazzuk a műveleteinket. A kiválasztott 
cellaformátumok a cellatartalom törlése után is megmaradnak. 
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7. kép 
A Szám fül 
 

 
 
Az Igazítás (Alignment) fül alatt a szöveg igazítását és a szöveg elhelyezkedését 

tudjuk meghatározni (el tudjuk forgatni a szöveget meghatároztt fokban, sortörést tudunk 
létrehozni, stb.). Az igazításra vonatkozó ikonokat a szokásos eszköztárban is 
megtalálhatjuk (Jobbra zárás, Középre zárás, Balra zárás). 
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8. kép 
Igazítások 
 

 
 

 
A Betűtípus (Font) panelen megtalálhatjuk a cellákban található szöveg (szám) 

betűtípusára vonatkozó minden beállítást (betűtípust, betűstílust, betűméretet 
választhatunk, meghatározhatjuk a betűtípus színét és különleges hatásokat 
alkalmazhatunk). A betűtípusra vonatkozó leggyakrabban használt parancsok a szokásos 
eszköztáron is megtalálhatóak (betűtípus, metűméret, félkövér, dőlt, aláhúzott hatások és 
a betűszín). 
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9. kép 
Betűtípusok 
 

 
 

 
A Szegély (Border) panelen a kijelölt cella vagy cellák határoló vonalát tudjuk 

beállítani. Meghatározhatjuk a vonal színét, stílusát és alkalmazhatjuk a kiválasztott 
oldalakra. A szegélyek módosítására a Szegélyek (Borders) eszköztár segítségével is 
lehetőségünk nyílik (Nézet > Eszköztárak > Szegélyek illetve a View > Toolbars > 
Borders pontra mutatva tudjuk megjeleníteni és elrejteni). A külső szegély 

meghatározására az szokásos eszköztáron is találunk egy ikont: . 
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10. kép 
A Szegély beállításai 
 

 
 
 A Mintázat (Patterns) fül alatt tudunk mintázatot és kitöltőszínt alkalmazni a 
kijelölt felületre.  
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11. kép 
A Mintázat 
 

 
 

A Védelem (Protection) résznél jelszóval tudjuk levédeni a kijelölt részt. Az 
Eszközök menü Védelem menüpontjával összhangban használhatjuk (Tools > 
Protection). A Védelem rész akkor lehet hasznos, ha a számítógépet több személy 
használja, és nem szeretnénk, hogy a többi felhasználónak betekintése legyen a 
dokumentumunkba.  
 A munkalapok füleit a helyi menü segítségével tudjuk módosítani (új beszúrása, 
törlés, átnevezés, átszínezés), illetve áthúzással tudjuk a munkalapok sorrendjét 
módosítani. 
 
12. kép  
A munkalapok füleinek helyi menüje 
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A sorok és az oszlopok átméretezése a cellahatárok áthúzásával történik. Ha 
egyszere több sort vagy oszlopot jelölünk ki, és így módosítjuk a cellahatárt, akkor a 
kijelölt rész egységesen fog növekedni vagy csökkenni. Duplán klikkelve a sorok vagy 
oszlopok határvonalára azt eredményezi, hogy a sor vagy oszlop akkora méretet vesz fel, 
hogy a legnagyobb tartalom is látható legyen. 
 
FELADATOK: 
1. Jelenítsük meg egy szöveget különböző elforgatással (45 fokonként) – 
D:\ECDL\modul3\formazas1.xls 
2. Készítsünk sakktábla-mintát (kijelöléskor használjuk a Ctrl billentyűt). Alakítsuk át a 
cellákat egységesen úgy, hogy négyzeteket alkossanak (a cellákat módosítva 
függőlegesen és vízszintesen is, legyenek 60x60 pixelesek). Írjunk az oszlopok előtti 
cellákba betűket, a sorok előttibe pedig számokat, amelyeket középre igazítunk 
függőlegesen és vízszintesen is. 
D:\ECDL\modul3\formazas2.xls 
3. Vigyünk be egy cellába egy hosszabb szöveget (nevünk, lakhelyünk, nemünk, 
szemünk színe). Másoljuk le ezt a szöveget négyszer. Az elsőre a Sortörés több sorba 
(Wrap text), a másodikra a Lekicsinyítve, hogy beleférjen (Shrink to fit), a harmadikra 
pedig a Cellák egyesítésével (Merge cells) utasítást alkalmazzuk. A negyedik lemásolt 
celláknál módosítsuk úgy a cellahatárokat, hogy az egész tartalom látható legyen. 
D:\ECDL\modul3\formazas3.xls 
4. Készítsünk iskolai órarendet az Excelben (cím 14-es félkövér Arial, szöveg 12-es 
Arial) a megfelelő cellák egyesítésével, színezésével és átméretezésével.  
D:\ECDL\modul3\formazas4.xls 
5. Mentsük el az órarendet xls, xlt és html fájlba, nyissuk meg ezeket a fájlokat 
6. Nyissuk meg az órarendünket, másoljuk a második munkalap fülre. Az eredeti táblázat 
címéhez írjuk hozzá a tavalyi évszámot, az újhoz pedig az ideit. Szúrjunk be két új sort 
(7. és 8. óra) az idei táblázatba. Az idei táblázat fülét nevezzük aktuális-ra és színezzük 
zöldre, a tavalyi órarend fülét, pedig színezzük szürkére. Az aktuális fület húzzuk az első 
helyre. 
D:\ECDL\modul3\formazas4.xls 
7. Engedélyezzük fekvő laptájolást, A4-es papírméretet, 3 cm-es margókat az oldal felső 
részére, 2 cm-es margókat az oldal többi részére 
D:\ECDL\modul3\formazas4.xls 
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Műveletek az Excelben 

 
Az Excel nem csak csak adatok tárolására, hanem műveletek elvégzésére is 

alkalmas. Az egyenlő "=" vagy a plusz "+" jellel kezdődő beírásokat kiszámítja.  
Az =45*9+789 vagy a +45*9+789 beírásának 1194 lesz az eredménye A cellában 

csak az eredmény jelenik meg, azonban ha a cella aktív, akkor a szerkesztőlécben a cella 
valódi tartalmát megjelenik. A műveletet azon cella kijelölésével kezdjük, ahová a 
művelet eredményét szeretnénk megjeleníteni. 
 
13. kép 
45*9+789 művelet eredményének megjelenítése a B1-es cellában 
 

 
 

A számtani alapműveletek (például összeadás, kivonás, szorzás, osztás) 
végrehajtásához, számok kombinálásához és az eredmények előállításához az alábbi 
matematikai jeleket használhatjuk:  
 
1. táblázat 
a számtani alapműveletek jelölése az Excelben 
 

művelet a jelölés neve  karakter 
összeadás (pluszjel) + 
kivonás vagy ellentett képzése (mínuszjel) – 
szorzás (csillag) * 
osztás (törtjel) / 
százalék (százalékjel) % 
hatványozás (pl. 3^2 - három a négyzeten) (kalap) ^ 

 
Ha egyetlen képletben több műveleti jelet vagy operátort adunk meg, az Excel a 

műveleteket a következő sorrendben hajtja végre: hatványozás, szorzás és osztás, 
összeadás és kivonás. A képlet azonos prioritású műveleteit (például szorzás és osztás) az 
Excel balról jobbra haladva értékeli ki.  

A végrehajtási sorrend módosításához az elsőnek kiértékelni kívánt képletrészt 
írjuk zárójelek közé. Például a =5+2*3 eredménye 11 lesz, mivel az Excel a szorzást az 
összeadás előtt hajtja végre. A képlet összeszorozza a 2-t a 3-mal, majd hozzáad 5-öt.  

Ha viszont a képletet módosítva zárójeleket használunk =(5+2)*3, akkor az Excel 
összeadja az 5-öt és a 2-t, majd az eredményt megszorozza 3-mal, amelynek a 
végeredménye 21.  

Legtöbbször a szerkesztőlécbe nem konkrét számokat, hanem cellahivatkozásokat 
írunk, amelyek a cellákban található számokat takarják. 



 

 
14. kép 
45*9+789 végrehajtása cellahivatkozásokkal 
 

 
 
FELADATOK: 
1. Próbáljuk ki az egyes műveleteket 
2. Jelenítsük meg a 5+2*3 B2-es, valamint a (5+2)*3 eredményét a D2-es a cellába 
D:\ECDL\modul3\muveletek1.xls 
3. A C3-as cellában jelenítsük meg a 45*9+789 művelet eredményét 
D:\ECDL\modul3\muveletek1.xls 
4. Oldjuk meg a fenti műveletet cellahivatkozások segítségével 
D:\ECDL\modul3\muveletek2.xls 
5. Készítsünk egy olyan táblázatot, amely kiszámítja az otthoni költségeinket, a bevételeket és a 
kiadásokat külön oszlopba, majd a végén adjuk össze az  oszlopokat, vonjuk ki a kiadásokat a 
bevételekből, majd a megkapott összeget fejezzük ki euróban. Bevételek: fizetés1: 30000, fizetés2 
25000, útiköltség1: 4000,  útiköltség2: 7800; Kiadások, fűtés: 2500, áram: 3200, telefon: 1200, 
élelmiszer: 9200, egyéb: 7600. Jelenítsünk meg vesszőt az ezres csoportok elválasztására, két tizedes 
számot, és a cellák formázásánál válasszuk a megfelelő pénznemeket, 
D:\ECDL\modul3\muveletek3.xls 
6. Készítsünk egy almaszedésről táblázatot (16 dátum, 4 csoport). Fejezzük ki ezután az egyes sorok, és 
oszlopok eredményeit (mennyi almát szedett le egy csoport, mennyi almát szedtek le egy napon). 
Ezután számoljuk ki, hogy mennyi almát szedtek le összesen, és mennyi maradt a fákon (becsült 
mennyiség). Végül számítsuk ki a leszedett almák (értékét-árát). Formázzuk és színezzük a táblázatot 
és mentsük el. 
D:\ECDL\modul3\muveletek4.xls 
7. Írjunk egy képletet a B2-es cellába, amely kiszámítja egy négyzet területét. Ezután írjunk egy 
képletet a C2-es cellába, amely kiszámítja egy négyzet kerületét (a négyzet oldalának hossza az A2-es 
cellába kerül). Formázzuk és színezzük a táblázatot, tüntessük fel az oszlopok megnevezéseit. 
D:\ECDL\modul3\muveletek5.xls 
8. Írjunk egy képletet a C2-as cellába, amely kiszámolja egy téglalap területét. Ezután írjunk egy 
képletet a D2-es cellába, amely kiszámítja a téglalap kerületét (a téglalap a oldalának hossza az A2-es 
cellába, a b oldala pedig a B2-es  kerül). Formázzuk és színezzük a táblázatot, tüntessük fel az oszlopok 
megnevezéseit. 
D:\ECDL\modul3\muveletek6.xls 
9. Írjunk képleteket a B2-es és a C2-es cellába, hogy annak a körnek kerületét és területét számítsa ki, 
amelyiknek sugarát az A2-es cellába írjuk! A kör kerülete: 2*pi*r, területe: pi*r^2 ahol a pi=3,14. 
Formázzuk és színezzük a táblázatot, tüntessük fel az oszlopok megnevezéseit. 
D:\ECDL\modul3\muveletek7.xls 
 
 
 



 16 

 
Képletek másolása (Autokitöltés) 

 
Táblázatkezelő használatakor gyakran előfordul, hogy a táblázat valamelyik oszlopát vagy sorát 

hasonló módon számítjuk ki. 
 

15. kép 
Egy osztály hiányzásai 

 

 
 
Az Autokitöltés a gyakorlatban egy osztály hiányzásainak a kiszámításánál tudjuk alkalmazni. Az 

eddig tanultak alapján ki tudnánk számolni az összmennyiségeket (Össz-hó, Össz-név), úgy hogy 
egyenként összeadnánk a megfelelő cellák tartalmait. Észrevehetjük, hogy a következő sor-oszlop 
képlete nagyon hasonló, csak a cellák sorszámai változnak. Egy nagyobb kiterjedésű táblázat esetében 
ez igen fáradságos munka lehetne a sorokat és az oszlopokat alkotó cellákat külön-külön összeadni. Az 
Autokitöltés (Autofill) funkció ezt a munkát egyszerűsíti le. 

Klikkeljünk a helyesen kiszámított cellára, ilyenkor a cella jobb alsó sarkában láthatunk egy kis 
fekete négyzetet (kitöltőnégyzet). 
 
16. kép 
A kitöltőnégyzet 
 

 
 

Ha erre vezetjük az egér mutatóját, megjelenik egy fekete kereszt . Az egér bal gombját 
lenyomva tartva a megfelelő cellák irányába mozgatjuk (ahol a képletet szeretnénk alkalmazni) Excel a 
megfelelő képletet fogja létrehozni ezekben a sorokban-oszlopokban. A program a cellahivatkozást 
tartalmazó képletet lefelé úgy másolja, hogy növeli eggyel a cellahivatkozásban a sorszámot. Fölfelé 
csökkenti eggyel. Jobbra történő másolásnál az oszlopazonosítót növeli, ha balra másolunk, akkor 
csökkenti azt.  

Ha egy cella cellahivatkozásokat és állandót (egy számot) is tartalmaz, akkor a képlet 
másolásakor az állandó nem változik. Például, ha egy cella tartalma =C1*D2+5, akkor ezt lefelé 
másolva alatta =C2*D3+5 kapunk.  
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FELADATOK: 
1. Jelenítsünk meg az 1-től 50-ig terjedő számokat autokitöltés segítségével 
D:\ECDL\modul3\autokitoltes1.xls 
2. Jelenítsük meg 1-től 50-ig a páros számokat autokitöltés segítségével 
D:\ECDL\modul3\autokitoltes1.xls 
3. Jelenítsük meg 1-től 50-ig a páratlan számokat autokitöltés segítségével 
D:\ECDL\modul3\autokitoltes1.xls 
4. Jelenítsük meg 1-től 50-ig a tizes számokat autokitöltés segítségével 
5. Jelenítsünk meg egy ismétlődő sort ötször autokitöltés segítségével (fiú-lány) 
D:\ECDL\modul3\autokitoltes1.xls 
6. Jelenítsük meg a 12 hónap neveit autokitöltés segítségével 
D:\ECDL\modul3\autokitoltes1.xls 
7. Hozzuk létre a létre a táblázatot, amely egy iskolai osztály hiányzásait tartalmazza. A nevek listáját 
hozzuk létre autokitöltés segítségével. 
D:\ECDL\modul3\autokitoltes2.xls 
8. Adjuk össze a tagokat egyenként (pl. D2+D3+D4+D5....), ezután alkalmazzuk a többi cellára az 
Autokitöltés funkciót. 
D:\ECDL\modul3\autokitoltes2.xls 
9. A nevek oszlopa elé szúrjunk be egy új oszlopot, és jelenítsük meg az egyes tagok sorszámát 
autokitöltés segítségével.Egyesítsük és színezzük a megfelelő színnel. A cellahatárok legyenek piros 
szaggatott, a táblázat körvonala pedig fekete 3-as vonal.Mentsük el a változásokat.  
D:\ECDL\modul3\autokitoltes2.xls 
 
 

Relatív és abszolút cellahivatkozások 
 

Készítsünk táblázatot egy iskolai büfé forgalmáról, amelyben meghatározott termékek, az áruk és 
az elfogyott mennyiség kap helyet.  

 
17. kép 
Az iskolai büfé táblázata a bevitt adatokkal 
 

 
 

Amikor elkészültünk a táblázattal, akkor számítsuk ki (az Autokitöltést is használva) a sorok és 
az oszlopok összegét. Ezzel a művelettel megkapjuk azt, hogy naponta mennyi termék fogyott 
összesen, egy termékből mennyi fogyott a hét folyamán és azt hogy a hét folyamán összesen mennyi 
termék fogyott. 
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18. kép 
Az iskolai büfé táblázata a kiszámított mennyiségekkel 
 

 
 

Ezután számítsuk ki azt, hogy egy nap és a héten mekkora bevételre tett szert a büfé 
(összeszorozzuk az árat az elfogyott mennyiséggel minden terméknél és összeadjuk az eredményeket). 
Ha ezt a képletet jobbra másoljuk, hibás eredményeket kapunk. Az első szorzatot: jobbra másolva ezt a 
képletet a B3*C3 helyett C3*D3-at kapunk. Összeszoroztuk a hétfőn és kedden eladott zsömlék 
számát. Nekünk az lenne a jó, ha a képlet másolása az “Ár” oszlopra mutató hivatkozásokat nem 
módosítaná. Ezt a hibát az abszolút cellahivatkozásokkal tudjuk kiküszöbölni. Abszolút hivatkozás az, 
ha az oszlop- és sorazonosító elé egy $ jelet (dollár) írunk. Például: $C$3. Ez a hivatkozás ugyanúgy a 
C3-as cellára mutat, ám ha így szerepel a képletekben, akkor másoláskor nem változik. Ha a C 
oszlopban találhatóak az árak, a D oszlopban pedig a hétfőn megvásárolt cikkek, akkor a következő 
lesz a hétfői nap bevételének a képlete: =$C$3*D3+$C$4*D4+$C$5*D5+$C$6*D6+$C$7*D7.  
 
Az Excelben a következő hivatkozásokat különböztetünk meg: 
 
=A1 (relatív hivatkozás) 
=$A1 (vegyes hivatkozás, az A oszlop rögzített) 
=A$1 (vegyes hivatkozás, az első sor rögzített) 
=$A$1 (abszolút hivatkozás, azaz rögzített cella) 
 

Jelöljük ki a kiszámított értékeket és a Tizedeshelyek növelése (Increase Decimal) és a 
Tizedeshelyek csökkentése (Decrease Decimal) kapcsolókkal állítsuk be, hogy két tizedesjegy legyen 
a cellákban. Így a cellák dinár és para értékeket mutatnak. Így a heti összbevétel 8217 dinár és 80 para 

lesz. A tizedeshelyek beállítását a következő ikonokkal tudjuk beállítani:  
 
19. kép 
Az iskolai büfé táblázata a bevitt és kiszámított adatokkal 
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FELADATOK: 
1. Tüntessünk fel tetszőleges bevételeket az A2:A10 tartományba, vigyük be az euro jelenlegi 
árfolyamát a D1-es cellába. Az A2:A10 tartományban jelenítsük meg az összes érték megfelelőjét 
euróban, alkalmazva a megfelelő jellegű hivatkozást. Formázzuk az egyes cellákat a pénznemnek 
megfelelően. 
D:\ECDL\modul3\relesabszhivatkozasok1.xls 
2. Készítsük el egy jegypénztár forgalmát 
D:\ECDL\modul3\relesabszhivatkozasok2.xls 
3. Hozzuk létre és töltsük fel az iskolai büfé forgalmát kimutató táblázatot. Számoljuk ki a megfelelő 
sorok és oszlopok összegét. Abszolút hivatkozások segítségével számoljuk ki az egyes napok 
bevételeit. Számoljuk ki a napi és a heti bevételt dinárban. Határozzuk meg a napi és a heti bevételt 
euróban. Mentsük el a változásokat. 
D:\ECDL\modul3\relesabszhivatkozasok3.xls 
7. Készítsünk szorzótáblát (10-ig), alkalmazzunk vegyes hivatkozásokat 
D:\ECDL\modul3\relesabszhivatkozasok4.xls 
 
 

Függvények alkalmazása 
 

A függvények olyan előre meghatározott képletek, amelyek argumentumnak nevezett különleges 
értékek használatával számításokat hajtanak végre. A függvények segítségével egyszerű vagy összetett 
számításokat végezhetünk. Például a =SZUM(A10:A15) függvény egyenértékű az 
=A10+A11+A12+A13+A14+A15 képlettel. Ebben a példában SZUM a függvény neve, az A10:A15 az 
argumentum. Az argumentumot mindig zárójel fogja közre. Van olyan függvény is, amelynek nincs 
argumentuma, a zárójeleket ilyenkor sem hagyhatjuk el. Például a π(pi) számot (kb. 3,14) az Excel 
nagyobb pontossággal is meg tudja jeleníteni a következő függvény segítségével: =PI().  
 
Leggyakrabban gyakran használt függvények 
 
1. SZUM (SUM) - Összeadja az argumentumlistájában lévő számokat.  
2. ÁTLAG (AVERAGE) - Az argumentumokban megadott számok átlagát (számtani közepét) adja 
meg.  
3. MAX (MAX) - Az argumentumai között szereplő legnagyobb számot adja meg.  
4. MIN (MIN) - Az argumentumai között szereplő legkisebb számot adja meg.  

 
Készítsünk egy olyan táblázatot, amely segítségével begyakorolhatjuk a négy függvény 

használatát! 
 

Készítsünk egy táblázatot egy osztály osztályzatairól! 
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20. kép 
Egy osztály érdemjegyei 
 

 
 

A következő oszlopban kiszámíthatjuk az Excel segítségével egy tantárgy összpontját (az 
osztályzatok összegét).  

Klikkeljünk a Név1 elnevezésű sor következő üres cellájára. Ide kerül majd az első tanuló 
osztályzatainak összege. 

A kijelölés után válasszuk a Beszúrás menü Függvény (Insert > Function) parancsát (vagy a 
szerkesztőléc mellett található fx gombot). Az ezután megjelenő panelről válasszuk ki a SZUM (SUM) 
függvényt, amely (amint a róla szóló leírás is elárulja) összeadja a kijelölt tartományba megtalálható 
számokat.  
 
21. kép 
A Függvény beszúrása panel 
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A függvény nevének kiválasztása után a függvényargumentumokat kell meghatározni. Az Excel 
által felkínált lehetőségek általában megfelelőek, azonban ezeket ellenőriznünk kell, majd a Kész (OK) 
gombra klikkelve engedélyezzük a függvény kiszámítását. Ha a felkínált érték nem megfelelő, akkor 
ezt törölni kell, majd a  gombra kattintva meghatározhatjuk a helyes argumentumot. Segítségként a 
mező mellett szerepelnek a cellákban található értékek, a várható eredmény és a függvény leírása. Az 
első cella kiszámítása után alkalmazni tudjuk az Autokitöltés műveletet. 
 
22. kép 
A függvényargumentumok meghatározása 
 

 
 
A tantárgyátlag kiszámítása is hasonló módon történik, csak itt az ÁTLAG (AVERAGE) 

függvényt kell választanunk. A tanuló átlagának kiszámítása a tantárgyak osztályzatainak átlagából áll 
össze.  

Az osztályátlag a tanulók egyéni átlagára alkalmazott ÁTLAG függvény.  
A legmagasabb átlagot a MAX függvény alkalmazásával (a tanulók átlaga oszlopra) kapjuk meg.  
A legalacsonyabb osztályzatot pedig a MIN függvény alkalmazásával kapjuk meg. A függvény 

argumentuma pedig az a mező lesz, ahova az összes osztályzatot beírtuk. 
 
23. kép 
A végleges táblázat 
 

 
 



 22 

 Az összeadás az egyik leggyakrabban alkalmazott művelet, ezért a szokásos eszköztáron is 
helyet kapott az AutoSzum (AutoSum)  ikon formájában. Az ikon lefelé mutató nyíl részére 
mutatva másik gyakran alkalmazott függvényt (átlag, maximum, minimum) tudunk választani. Itt 
találjuk meg a Darabszám (Count) függvényt is, amely segítségével a bejelölt cellák számát tudjuk 
megjeleníteni. 
 A terjedelmes táblázatok esetében, az olvashatóságot megkönnyítve alkalmazzuk az egyes 
sorokra vagy oszlopokra az Ablaktábla rögzítése (Freeze Panes) parancsot. A rögzített rész határát 
egy függőleges vonal jelzni, amelyet az Ablaktábla feloldása (Unfreeze Panes) paranccal oldunk fel. 
 Előfordulhat, hogy egyes sorokat vagy oszlopokat szeretnénk elrejteni a táblázatból. Ezt az 
opciót a sor vagy az oszlop kijelölése után a helyi menüből a Hide (Elrejtés) parancsra klikkelve érjük 
el. Az elrejtett cellák cellaértéke továbbra is megmarad, illetve ha függvénybe van foglalva, akkor 
továbbra is elérhető lesz. Ezt az opciót a Felfedés (Unhide) paranccsal szüntetjük meg, amelyet szintén 
a helyi menüből érünk el. 
 
FELADATOK: 
1. Készítsünk el egy táblázatot, amelyben feltüntetjük egy iskolai osztály érdemjegyeit. Számoljuk ki a 
tantárgyak átlagát, a tanulók osztályzatainak összegét, a tanulók átlagát, az osztály átlagát, a 
legmagasabb átlagot és a legalacsonyabb osztályzatot. Rögzítsük (freeze) a táblázat első oszlopát, 
amelyben a neveket tüntettük fel. Mentsük el a változásokat. 
D:\ECDL\modul3\fuggvenyek1.xls 
2. Tüntessük el azokat az oszlopokat, amelyekben az osztályzatok találhatóak. 
D:\ECDL\modul3\fuggvenyek1.xls 
3. A cellahatárok módosítása nélkül, hozzuk a táblázatot olyan alakba, hogy ráférjen egy A4-es lapra  
D:\ECDL\modul3\fuggvenyek1.xls 
4. Számítsuk ki az almaszedés táblázatában az egyes napok, és egyes csoportok átlagát, majd a 
csoportok legalacsonyabb, és legmagasabb teljesítményét 
D:\ECDL\modul3\muveletek4.xls 
 
Logikai (Logical) függvények 
 

A HA (IF) függvényt gyakran használjuk feladatokban, ezzel a függvénnyel feltételes 
vizsgálatok hajthatók végre értékeken és képleteken. Más értéket ad vissza, ha a megadott feltétel 
kiértékelésének eredménye IGAZ, s mást ha a kiértékelés eredménye HAMIS.  

A HA függvénynek három argumentuma van. Az első a Logikai_vizsgálat (Logical_test) ide 
írjuk a feltételt, amelyben megtalálható egy logikai operátor (például: A1>30). A következő 
argumentum az Érték_ha_igaz (Value_if_true) a beírt szöveg (vagy más) akkor jelenik meg a 
cellában, ha a feltétel igaz. A harmadik argumentum Érték_ha_hamis (Value_if_false), amely akkor 
jelenik meg, ha a feltétel hamis.  

 
Az Excelben a következő összehasonlító operátorokat használhatjuk: 
 

= egyenlőségjel  
> nagyobb, mint jel  
< kisebb, mint jel 
>= nagyobb vagy egyenlő jel  
<= kisebb vagy egyenlő jel  
<> nem egyenlő jel  
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24. kép 
A HA függvény argumentumainak beállítása 
 

 
 
 
FELADATOK: 
1. Készítsünk egy táblázatot, amelyben egy elképzelt felvételi pontszámai jelennek meg. Ha a 
pontszám 50 pontnál magasabb, akkor a „Felvételt nyert”, ha pedig alacsonyabb, akkor a „Nem nyert 
felvételt” üzenet jelenik meg. A dokumentum fejlécében jelenítsük meg a „Felvételi” szövegetl 
valamint a fájl nevét, a lábjegyzetben pedig a dátumot és időt. 
D:\ECDL\modul3\fuggvenyek2.xls 
2. Jelenítsük meg a büfé forgalma táblázatban a „magas bevétel” feliratot ha a bevétel nagyobb 1500-
nál, és az „alacsony bevételt”, ha a bevétel kisebb 1500-nál. Mentsük el a változásokat. 
D:\ECDL\modul3\relesabszhivatkozasok3.xls 
 
Egyéb függvények 
 
 A DARAB (COUNT) függvény eredményét az adja meg, hogy hány szám található a 
függvényargumentumba. 

A DARABTELI (COUNT IF) függvény eredményét az adja meg, hogy hány szám található a 
függvény argumentumába, amely megfelel a meghatározott kritáriumnak. 
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25. kép 
A függvény argumentumainak a meghatározása 

 

 
 
A FKERES (VLOOKUP) függvény egy tömb bal szélső oszlopában keres egy megadott 

értéket, és az így kapott sorból veszi az oszlop_szám argumentummal kijelölt cellát, és ennek tartalmát 
adja eredményül. A függvény gyakorlati felhasználásában segédtáblázatok segítségével, 
automatikusan, bírálható el egy adott érték. 
 
26. kép 
A FKERES függvény  argumentumainak beállítása 
 

 
 
A Keresési_érték (Lookup_value) mezőben arra a cellára kell hivatkoznunk, amelyből az 

eredmény következik (keresendő érték) 
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Tábla (Table_array) az a rész, amelyben a keresést végre kell hajtani. 
Oszlop_szám (Col_index_num) a tábla azon oszlopa, amelyből az eredményt meg kívánjuk 

jeleníteni. 
 

27. kép 
A táblázat egy része 
 

 
 
 A fenti képen egy táblázat részlete látható, amely az összegyűjtött pontokat figyelembe véve 
határozza meg az osztályzatot. Ebben az esetben a Pontszám oszlop első cellája (22) lesz a Keresési 
érték. A Tábla ebben az esetben a sárga segédtáblázat lesz. Az Oszlop szám értéke az Osztályzatok 
azon részén, amelynél az osztályzatokat számokkal fejeztük ki 2, a következő oszlopban pedig 3 lesz.   
 
FELADATOK: 
1. Készítsünk egy táblázatot, amely összeadja 5 feladat pontszámát, egy másik táblázat szerint 
kiszámolja az érdemjegyet és emellett a megfelelő szót is megjeleníti (pl: jeles). 
D:\ECDL\modul3\fuggvenyek3.xls 
2. Függvény segítségével jelenítsük meg azt, hogy az aktuális héten hány árúcikk került eladásra. 
D:\ECDL\modul3\relesabszhivatkozasok3.xls 
3. Függvény segítségével jelenítsük meg az osztályzatok táblázatból az egyesek, a kettesek, a 
hármasok, a négyesek és az ötösök számát. 
D:\ECDL\modul3\fuggvenyek1.xls 
4. Módosítsuk az átlagszámítást úgy, hogy 1 legyen az átlag, ha az osztályzatok között szerepel egyes 
D:\ECDL\modul3\fuggvenyek1.xls 
5. Tetszőleges számsorok segítségével jelenítsük meg az összes megismert függvényfunkciót 
D:\ECDL\modul3\fuggvenyek4.xls 
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Pénznem, Százalék és Dátum 
 

A pénzem, százalék és a dátum beállítását a cellák formázásánál határozhatjuk meg, vagy pedig 
a szokásos eszköztár ikonjára klikkelve állíthatjuk be. 
 
Pénznem(Currency Style)  
 
 Bekapcsolásával a szám elé dollárjelet jelenít meg a szoftver, és két tizedesszám megjelenítését 
kapcsol be.  
 
Százalékszámítás (Percent Style)  

 
Ha a százalékformátumot választjuk a szokásos eszköztárról vagy a Cellák formázása panelen a 

Szám mezőben, akkor az Excel  a számot megszorozza 100-zal, a megjelenő érték után a % jelet teszi, 
a tizedesjegyek számát pedig 0-ra állítja. Ezután a szerkesztőlécben is százalék jelenik meg, de a szám 
valódi értéke továbbra is 100-szor kisebb lesz. 
 Ha egy cellába százalékértéket írunk (pl.: 25%), akkor a program bekapcsolja a 
százalékformátumot, de a cella értéke 0.25 marad itt is. 
 Százalékszámítást úgy tudunk elérni, ha összeszorozzuk a százalékot és az értéket tartalmazó 
mezőt. 
 
28. kép 
A százalékszámítás megvalósulása 
 

 
 

 Azt, hogy egy szám a másik számnak hány százaléka azt úgy kapjuk meg, ha elosztjuk őket, 
ezután az eredmény cellájában a százalékformátumot kapcsoljuk be. A megjelenő eredménynél az 
osztott szám lesz az osztó százaléka. 
 
29. kép 
A százalékszámítás megvalósulása 
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FELADATOK: 
1. A B3-as cellába számítsuk ki azt, hogy hány nap telt el 1900. január 1. óta. 
D:\ECDL\modul3\datum1.xls 
2. A C1-es cellába vigyük be saját születési dátumunkat. Számítsuk ki a B4-es cellába azt, hogy hány 
nap telt el a születésünktől (vonjuk ki a mai dátumból a születésünk dátumát – a cellára, amelybe az 
eredmény kapjuk, alkalmazzunk Általános formázást). A következő cellába jelenítsük meg az 
életkorunkat években (a napokat osszuk el 365-tel) 
D:\ECDL\modul3\datum1.xls 
3. Készítsünk táblázatot egy konferencia előadóiről, amelyben helyet kap az érkezés ideje, a távozás 
ideje, és ennek függvényében az előadó napidíja. A táblázat alá jelenítsük meg a mai dátumot, a 
konferencia kezdetének a dátumát, és azt hogy hány nap múlva kezdődik a konferencia. 
D:\ECDL\modul3\datum2.xls 
 
Dátumformátum (Date) 
 

A Microsoft Excel a dátumokat dátumértéknek nevezett sorszámként tárolja. Alapértelmezés 
szerint 1900. január 1. megfelelője az 1-es sorszám, míg például a 2007. május 3. dátumhoz a 39205 
szám tartozik, hiszen 39205 nap múlt el 1900. január 1. után. 

Az Excel a nap kisebb részeit (óra, perc, másodperc) tizedes törtként tárolja, mivel ezt a nap 
részének tekinti. 

Láthatjuk, hogy a dátumok és ezek alkotóelemei matematikai értékek, amelyeket 
összeadhatunk, kivonhatunk, illetve egyéb számításokba is elvégezhetünk segítségükkel.  
 A függvényeknél egy kategória vonatkozik a dátum és idő függvényeire. A leggyakrabban 
használt a =MA (), amelyet az angol nyelvű szoftverben =NOW () utasítással jelöl a szoftver. Ha angol 
nyelvű szoftvert használunk, akkor gondot okozhat a magyar írásmódnak megfelelő dátum 
megjelenítése, illetve átalakítása. Ilyenkor használjuk az amerikai dátumjelölést (hónap/nap/év - 
5/3/2007). 
 
FELADATOK: 
1. Készítsük el a táblázatot, amely a tankönyvek árát számolja ki, ha 10 darab esetén 1.5, 30 darab 
esetén 2.8 százalékos kedvezményt kapunk a kiadótól. 
D:\ECDL\modul3\szazalek1.xls 
2. Készítsünk táblázatot, amely az iskolai büfé készletét tartja számon és kiszámítja, hogy egyes 
termékek hány százaléka fogyott el.  
D:\ECDL\modul3\szazalek2.xls 
3. Készítsünk egy táblázatot, amely összeadja az egyes bevételeket négy hónapra, kifejezi a bevételek 
százalékos arányát (alkalmazzunk vegyes hivtkozást és másoljuk az egész oszlop képletét). Jelenítsük 
meg, hogy hány hónapot számoltunk, valamint vessük össze a kapott eredményt az előző négy 
hónappal, és elbírálja el a program, hogy van-e bevételnövekedés 
D:\ECDL\modul3\szazalek3.xls 
 
 
 
 
 
 



 28 

 
 
 

Adatok rendezése  
 

A szokásos eszköztár tartalmaz két ikont, amelyekkel rendezhetjük adatainkat, de ezeket csak 
akkor használjuk, ha egy oszlop tartalmát akarjuk rendezni. Az adatokat rendezhetjük Csökkenő (Sort 
Ascending) és Növekvő (Sort Descending) sorrendbe.  

Táblázatos adatok rendezéséhez jelöljük ki adatainkat és válasszuk az Adatok menüpont Sorba 
rendezés parancsát (Data > Sort). Itt meghatározhatjuk azt, hogy milyen szempontok szerint rendezze 
a program a kiválasztott adatainkat. Ha több szempont szeretnénk rendezni, akkor meg kell határozni, 
hogy melyik az első, a második, esetleg a harmadik rendezési szempont.  

Az Egyebek (Options) panel alatt további beállításokat tudunk meghatározni. 
Meghatározhatjuk a rendezés irányát (felülről lefelé vagy jobbról balra) vagy a rendezést kis- és 
nagybetűk szerint. 

 
30. kép 
Adatok rendezésének a szempontjai 

 

 
 
 
FELADATOK: 
1. Vegyünk fel tetszőleges számokat egy oszlop celláiba. Másoljuk az oszlop celláit a két következő 
oszlopba. Ezután rendezzük a második oszlopot növekvő, a harmadikat pedig csökkenő sorrendbe az 
Eszköztáron található ikonnal 
D:\ECDL\modul3\rendezes1.xls 
2. Készítsünk egy tetszőleges osztály érdemjegyeiből álló táblázatot. Másoljuk le ezt a táblázatot 
kétszer. Az első lemásolt táblázatot rendezzük nevek ABC sorrend szerint, a másodikat pedig az 
osztályzatok szerint 
D:\ECDL\modul3\rendezes2.xls 
3. Készítsünk táblázatot egy évfolyam hallgatóiról. Az oszlopokba a nevek mellé a vizsga érdemjegye, 
a szeminárium érdemjegye, és a kollokvium eredménye kerül. Másoljuk ezt a táblázatot az első alá. A 
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második táblázatban az adatokat rendezzük csökkenő sorrendben a következő szempontok alapján 
(vizsga, kollokvium, szeminárium) 
D:\ECDL\modul3\rendezes3.xls 
 

Diagramok  
 

 A diagramokkal grafikus módon ábrázolhatjuk adatainkat, ezzel szemléletesebbé téve azokat. 
Legegyszerűbben a Diagramvarázsló (Chart Wizard) segítségével készíthetünk diagramokat, 
előzőleg kijelölve azokat a cellákat, amelyek alapján felépül a diagramunk. 
 A diagram készítésének első lépése a megfelelő cellatartományok kijelölése (nem összefüggő 
cellák kijelölésénél használjuk a Ctrl billentyűt). 
 Ezután indítsuk el a Diagramvarázslót. A diagramvarázsló első ablakában Diagramtípusok 
(Chart Type) és azon belül Altípusok (Chart sub-type) közül választhatunk. A Minta 
megtekintéséhez tartsa lenyomva (Press and Hold to View Sample) gombra kattintva a leendő 
diagramunk az Altípusok helyén jelenik meg. A következő lépésre Tovább (Next) gombra klikkelve 
térünk át. 
 
31. kép 
A diagramkészítés első lépése 
 

 
 

A diagram varázsló második ablaka már mutatja a diagram mintáját és a cellatartományt 
abszolút hivatkozásként, amelyik alapján készül a diagram. Például: 
=Munka1! $D$7:$M$8. Láthatjuk, hogy a címben a munkalap neve is szerepel. Utána egy 
felkiáltójellel. A Microsoft Excelben így kell hivatkozni cellákra munkalapok között. 
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Az Adatsor (Series) módosíthatjul és nevet adhatunk a diagram adatsoraként szolgáló cellákat.  
A Back (Vissza) gombra klikkelve visszatérünk az előző lépésre, a Mégse (Cancel) gombra 

klikkelve megszakítjuk a folyamatot. 
 

32. kép 
A diagramkészítés második lépése 

 

 
 
A Diagramvarázsló harmadik lépésének paneljén hat fül található. A panelen elvégzett 

módosítások megjelennek a panel jobb oldalán látható diagramon. 
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33. kép 
A diagramkészítés harmadik lépése 
 

 
 
 A Címek (Titles) fülön az egész diagram címét, illetve az x és az y tengely elnevezését tudjuk 
meghatározni. 
 A Tengelyek (Axes) résznél a tengelyek értékeinek a megjelenítését tudjuk beállítani (akár el is 
tüntetni). 
 A Rácsvonalak (Gridlines) fülnél meghatározhatjuk a diagram rácsvonalainak fajtáit és 
megjelenítését. 
 A Jelmagyarázat (Legend) fül alatt a jelmagyarázat elhelyezését tudjuk beállítani. 

A Feliratok (Data Labels) fülön a diagramunkon szereplő szöveg beállításait tudjuk elvégezni. 
Az Adattábla (Data Table) résznél a diagramot alkotó adatokat tudjuk táblázatszerűen 

megjeleníteni, a diagram felületén. 
A diagramvarázsló negyedik ablakában választhatunk, hogy a táblázatunk munkalapján 

(Objektumként itt: - As object in:), vagy Új munkalapon (As new sheet:) jöjjön létre a diagram. 
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34. kép 
A diagramkészítés negyedik lépése 

 

 
 

A diagramot utólag is formázhatjuk, ha duplán kattintunk arra a diagramelemre (háttér, tengely, 
stb.), amelyet módosítani szeretnénk. Az utólagos formázásban módosítani tudjuk a Diagram varázsló 
segítségével beállított értékeket, meg tudjuk határozni a mezők színét, mintázatát és körvonalát. 

 
35. kép 
A digramelemek módosítása 
 

 
 

FELADATOK: 
1. Készítsünk egy olyan diagramot, amely vonal formájában jeleníti meg a Név3 hiányzásait az év 
folyamán (használjunk vastagabb piros vonalat, és jelenítsük meg az értékeket a diagramon. 
D:\ECDL\modul3\autokitoltes2.xls 
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2. Fagyasszuk le az első oszlopot. Hozzunk létre egy olyan vonaldiagramot, amely összehasonlítja a 
Név2, a Név5 és a Név9 hiányzásait. Alkalmazzunk világos kék hátteret a diagramnál, válasszunk 
vastagabb vonalvastagságot 
D:\ECDL\modul3\autokitoltes2.xls 
3. Készítsünk oszlopdiagramot a négy hónap bevételeinek az eloszlásáról, alkalmazzunk a diagram 
hátterére citromsárga színt. 
D:\ECDL\modul3\szazalek3.xls 
4. Jelenítsük meg a márciusi bevételeket kördiagram formájában, jelenítsük meg az egyes szeleteknél 
az értékeket. 
D:\ECDL\modul3\szazalek3.xls 
5. Készítsünk kördiagramot egy iskolai kirándulás költségeinek az elosztásáról, jelenítsük meg az egyes 
szeleteknél a százalékot. Alkalmazzunk az egyes szeletekre olyan mintát, amely fekete-fehér 
nyomtatásban is jól látható. 
D:\ECDL\modul3\diagram1.xls 
6. Készítsünk egy táblázatot egyes hónapok bevételéből. Fejezzük ki az összegeket forintban is. 
Számoljuk ki, hogy mennyi az egész évi bevétel, és azt hogy hány érték van 100 000 din felett. A 
segédtáblázat segítségével értékeljük az egyes hónapok bevételeit.  
D:\ECDL\modul3\diagram2.xls 
7. Számoljuk ki a forgalmi adót és a bruttó összegeket. Fejezzük ki oszlopdiagram formájában az egy 
év alatt megvalósított bevételeket, valamint a teljes összeg és a forgallmi adó arányát. 
D:\ECDL\modul3\diagram2.xls 
 
 

Dokumentumok nyomtatása 
 

 Az egyes dokumentumok kinyomtatása megegyezik a Word programban ismertetett művelettel. 
Azzal, hogy a Nyomtatási kép (Print Preview) gomb lenyomása után láthatóvá vállnak az oldal 
határai. A Nyomtatás panelen (Print) kiválasztható az, hogy mit kívánunk nyomtatni: A kijelölt 
terület (Selection), A kijelölt munkafüzetlap (Active sheet(s)), A teljes munkafüzet (Entire 
workbook).A Nyomtatás fájlba (Print to file) opció is a Word programban megismertetett módon 
működik. 
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36. kép 
nyomtatási panel 
  

 
 
FELADATOK: 
Jölöljük ki a D:\ECDL\modul3\autokitoltes2.xls dokumentumból a táblázatot. Nyomtassuk ki fájlba a 
kijelölt részt. 
 

 

 
 
 

 



Mgr. Námesztovszki Zsolt 
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Szabadka, 2009. 
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Bevezető 

Az Excel táblázatkezelő program és a Micrsosoft Office, irodai programcsomag 
része. A táblázatkezelő program feladata táblázatosan elrendezett adatok hatékony és 
látványos kezelése. Általában költségvetések, előrejelzések elkészítésére, egyéb pénzügyi 
és matematikai feladatok megoldására alkalmazzuk. A táblázatkezelők rendszerint 
rendelkeznek adatbázis-kezelő funkciókkal és diagramok is létrehozhatók velük. Ezek a 
programok az adatértékeket cellákba rendezve tartalmazzák, a cellák tartalma közötti 
kapcsolatokat pedig megfelelő képletekkel fejezzük ki. 
 
Az Excel lehetőségei a az oktatásban 
 

Microsoft Excel programot az oktatásban a órarendkészítésre, hiányzások 
kiszámítása, átlagszámításra, különböző költségek kiszámítására és diagrammok 
készítése (pl. tanulmányi átlagból) tudjuk felhasználni. Hasznos segédeszköz lehet  a 
mérések, kísérletek és megfigyelések eredményeinek tárolásánál és az ezekkel történő 
műveletek elvégzésénél. A táblázatban található adatokból könnyen készíthetünk 
diagramokat is, amely a hatékonyabb szemléltetést és áttekintést tesz lehetővé. 

 A programot magyar nyelvre is lefordították, munkánkban az angol és a magyar 
kifejezéseket is feltüntettük (mivel a magyar szakszavak a számítástechnikában még nem 
terjedtek el eléggé). A mintatáblázatoknál kék színnel jelöltük a megnevezéseket, zölddel 
a bevitt adatokat és pirossal azokat a cellákat, amelyekbe a számítási műveletek 
eredménye fog kerülni. Hatásos, ha a saját táblázatok elkészítésénél a táblázat 
határolóvonalának a  meghatározásánál vastagabb vonalakat használunk, mint amilyenek 
a cellák körvonalai.  
 

Alapműveletek 
 
A szoftver futtatása 
 

A programot legegyszerűbben a Start menü All Programs > Microsoft Office > 
Microsoft Office Excel 2003 parancsának segítségével futtathatjuk. 
 
A programablak részei 
 

A program elindulásakor megjelenő képernyő közepén sorokból és oszlopokból 
álló rácsos elrendezésű táblázatot látunk, ahol az oszlopokat nagybetűk (A, B, C, D, AA), 
míg a sorokat egész számok (1, 2, 3, 4, ...) jelölik. A táblázat legkisebb eleme a Cella 
(Cell). A cella egy sor és oszlop metszéspontja, s rá úgy hivatkozhatunk, hogy először az 
oszlop nevét, majd a sor számát adjuk meg. A táblázat bal felső sarkában az A1-es cella 
található, mellette közvetlenül a B1-es cella van, míg az A1-es alatt az A2-es.  

Ezt a táblázatot Munkalapnak (Sheet) nevezzük. Az Excelben több munkalapon 
dolgozhatunk. Ezek közül egy mindig aktív. A munkalapokat a program Munka1 
(Sheet1), Munka2 (Sheet2)… módon jelöli. Ha kettőt kattintunk az egérrel a feliraton, 
átnevezhetjük azt, Enter-el nyugtázva a beírást.  
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Az egérmutatóval a lapfülre mutatva, az egér bal gombját lenyomva tartva, 
áthúzással módosíthatjuk a munkalapok sorrendjét. Jobb egérgombbal kattintva a 
lapfülön, helyi menü jelenik meg, ahol több lehetőség közül is választhatunk, új 
munkalapot szúrhatunk be, törölhetjük, átnevezhetjük, másolhatjuk a munkalapot, 
valamint meghatározhatjuk lapfül színét (fehér az alapbeállítás). 
 
1. kép 
Az Excel programablak részei 
 

 
 
Mentés 
 

A mentés hasonló módon történik, mint a Wordben. Amikor a mentésre 
kattintunk, az összes munkalapot, azaz a munkafüzetet mentjük el. Az így létrejött fájl, 
vagyis az Excel munkafüzet kiterjesztése - .xls.  
 
Fájltípusok 
 
 A 2003-as Excel legismertebb fájltípusai: xls (munkafüzet), xlt (sablon) és a htm 
(weblap). A 2007-es Excel ezeket a fájlokat xlsx és xltx kiterjesztéssel jeleníti meg. 
 
Olalbeállítás 
 

Szerkesztőléc 
Kijelölt cella 

Sorazonosító 

Oszlopazonosító 

Cella 

Aktív munkalap 
Munkalap füle 
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A Fájl  > Oldalbeállítás (File > Page) panelen határozhatjuk meg az oldal 
alapbeállításait, engedélyezhetünk a lapnak álló vagy fekvő tájolást, illetve beállíthatjuk a 
margókat. 

Gyakran előfordul, hogy a táblázatot egy oldalra szeretnénk kinyomtatni, a 
cellahatárok módosítása nélkül. Ilyen esetekben alkalmazzuk a Fájl  > Oldalbeállítás 
(File > Page Setup) Oldal (Page) fülén található Legyen az eredeti méret 
meghatározott %-a (Adjust to _% normal size) utasításokat, illetve a Legyen 
meghatározott oldal széles és meghatározott oldal magas (Fit to page(s) _ wide by _ 
toll). 

Az Élőfej és élőláb (Header/Footer) fül segítségével tudunk élőfejeket és 
élőlábakat létrehozni sablon szerint (a listáról választva), illetve tetszőlegeset az Egyéni 
(Custom) opciót választva, illetve az egyéni szöveget beírva. Az élőfejek és az élőlábak a 
nyomtatási képen. illetve a nyomtatásban láthatóak. 
 
2. kép 
Oldalbeállítás 
 

 
 
 
Kijelölés 
 

Az egyes cellák kijelölése bal egérklikkeléssel történik, összeföggő cellák 
kijelölése egér behúzással, az elkülönülő celláké pedig CTRL + egérklikkelés 
segítségével. A teljes munkalap kijelölés CTRL + A vagy a oszlop- és sorazonosítók 
metszésénél található négyzetre kattintva történik. 
 
FELADATOK: 
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1. Próbáljuk ki az egyes kijelölési módokat 
 
A szerkesztőléc 
 

Az oszlopazonosítók fölött a Szerkesztőléc található, aminek bal szélén az aktív 
cella címe, jobbra pedig a tartalma látható.  
 
 
3. kép 
A szerkesztőléc 
 

 

 
Adatbevitel 
 

Az Excel celláiba alapesetben szöveget vagy számot írhatunk. A beírt adatot az 
iránybillentyűkkel („nyíl” billentyűkkel) vagy az Enterrel nyugtázhatjuk. A “Delete” 
billentyű törli az aktív cella tartalmát. A cella tartalmát módosíthatjuk, ha kettőt 
kattintunk rá, vagy az F2-es funkcióbillentyűvel. Ha számot írunk be, legyen az egész 
vagy tizedes szám, az Excel a cellán belül jobbra igazítja. Ha szöveget viszünk be, akkor 
azt az Excel balra igazítja a cellán belül. 
 
Cellák beszúrása 
 
 Gyakran előfordulhat, hogy már elkészült táblázatban szeretnénk újabb sort vagy 
oszlopot beszúrni. Ezt megtehetjük a helyi menü Beszúrás (Insert) vagy a Beszúrás 
menü Sorok (Rows) vagy Oszlopok (Columns) pontjára mutatva. Miután a Beszúrás 
menüpontra mutattunk, egy panel jelenik meg, amelyen meghatározhatjuk, hogy a cellák 
merre tolódjanak el a beszúrás után. Itt tudjuk meghatározmi azt is, hogy sort vagy 
oszlopot kívánunk beszúrni. 
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4. kép 
A Cellák beszúrása parancs után megjelenő panel 
 

 

 

A cellák formázása 
 

Az adatbevitel után gyakran előfordulhat, hogy a beírt szöveg nem fér el a 
cellában, és a mellette lévő cella üres, akkor a szöveg "átcsúszik" következő cellába is. 
Ha ez a cella tartalmaz adatot, akkor a beírt szövegnek csak egy részét láthatjuk. 
Amennyiben az oszlopazonosítók (oszlopfejléc) valamely elválasztó vonalára vezetjük az 
egér mutatóját, és az egér bal gombját lenyomva tartva jobbra-balra mozgatjuk, a vonaltól 
balra eső oszlop szélességét módosíthatjuk. Hasonlóképpen módosíthatjuk a sorok 
magasságát is. 

A Formázás eszköztáron találjuk a Cellaegyesítés (Merge and Center) gombot. A 
Cellaegyesítés parancsot a következő ikon jeleníti meg: . Ezzel több kijelölt cellát 
egyesíthetünk. Az így kialakult terület elfoglalja az előzőleg kijelölt cellákat, amire 
ezután a bal felső cella cellacímével hivatkozhatunk, s a benne lévő adatok középre 
igazítva jelennek meg. A cellaegyesítést leggyakrabban a táblázatok nevének 
megadásakor használjuk. 

 
5. kép 
A Cellaegyesítés utasítás 

 

 
 
Összefüggő cellákat egérrel, illetve a Shift billentyűt lenyomva tartva, 

iránybillentyűkkel jelölhetjük ki. Kijelölhetünk nem összefüggő tartományokat is. 
Ilyenkor az első terület (vagy cella) kijelölése után a Ctrl billentyűt lenyomva kell 
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tartanunk. Az oszlop- vagy a sorazonosítókra kattintva egész sorokat és oszlopokat is 
kijelölhetünk. Az oszlop- és sorazonosítók találkozási pontjánál található szürke 
négyzetre klikkelve a teljes munkalapot kijelölhetjük. 

A Cellák formázása (Format Cells) utasítással az aktív cellát, vagy a kijelölt 
területet (tartományokat) tulajdonságait módosítjuk. A parancsot a jobb kattintás után 
találjuk meg a megjelenő helyi menüben.  
 
6. kép 
A cellák formázására szolgáló panel 
 

 
 

A Szám (Number) fülön meghatározhatjuk a cellában megtalálható szám 
megjelenítési módját (általános, szám, százalék, tört). A kategória kiválasztása után 
finomabb beállításokat eszközölhetünk. Kiválaszthatjuk a pénznemet, a tizedesek, 
számát, a dátumformátumot. A Minta (Sample) mezőben megtekinthetjük azt, hogy 
hogyan fog majd kinézni az a rész, amelyre alkalmazzuk a műveleteinket. A kiválasztott 
cellaformátumok a cellatartalom törlése után is megmaradnak. 
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7. kép 
A Szám fül 
 

 
 
Az Igazítás (Alignment) fül alatt a szöveg igazítását és a szöveg elhelyezkedését 

tudjuk meghatározni (el tudjuk forgatni a szöveget meghatároztt fokban, sortörést tudunk 
létrehozni, stb.). Az igazításra vonatkozó ikonokat a szokásos eszköztárban is 
megtalálhatjuk (Jobbra zárás, Középre zárás, Balra zárás). 
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8. kép 
Igazítások 
 

 
 

 
A Betűtípus (Font) panelen megtalálhatjuk a cellákban található szöveg (szám) 

betűtípusára vonatkozó minden beállítást (betűtípust, betűstílust, betűméretet 
választhatunk, meghatározhatjuk a betűtípus színét és különleges hatásokat 
alkalmazhatunk). A betűtípusra vonatkozó leggyakrabban használt parancsok a szokásos 
eszköztáron is megtalálhatóak (betűtípus, metűméret, félkövér, dőlt, aláhúzott hatások és 
a betűszín). 
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9. kép 
Betűtípusok 
 

 
 

 
A Szegély (Border) panelen a kijelölt cella vagy cellák határoló vonalát tudjuk 

beállítani. Meghatározhatjuk a vonal színét, stílusát és alkalmazhatjuk a kiválasztott 
oldalakra. A szegélyek módosítására a Szegélyek (Borders) eszköztár segítségével is 
lehetőségünk nyílik (Nézet > Eszköztárak > Szegélyek illetve a View > Toolbars > 
Borders pontra mutatva tudjuk megjeleníteni és elrejteni). A külső szegély 

meghatározására az szokásos eszköztáron is találunk egy ikont: . 
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10. kép 
A Szegély beállításai 
 

 
 
 A Mintázat (Patterns) fül alatt tudunk mintázatot és kitöltőszínt alkalmazni a 
kijelölt felületre.  
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11. kép 
A Mintázat 
 

 
 

A Védelem (Protection) résznél jelszóval tudjuk levédeni a kijelölt részt. Az 
Eszközök menü Védelem menüpontjával összhangban használhatjuk (Tools > 
Protection). A Védelem rész akkor lehet hasznos, ha a számítógépet több személy 
használja, és nem szeretnénk, hogy a többi felhasználónak betekintése legyen a 
dokumentumunkba.  
 A munkalapok füleit a helyi menü segítségével tudjuk módosítani (új beszúrása, 
törlés, átnevezés, átszínezés), illetve áthúzással tudjuk a munkalapok sorrendjét 
módosítani. 
 
12. kép  
A munkalapok füleinek helyi menüje 
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A sorok és az oszlopok átméretezése a cellahatárok áthúzásával történik. Ha 
egyszere több sort vagy oszlopot jelölünk ki, és így módosítjuk a cellahatárt, akkor a 
kijelölt rész egységesen fog növekedni vagy csökkenni. Duplán klikkelve a sorok vagy 
oszlopok határvonalára azt eredményezi, hogy a sor vagy oszlop akkora méretet vesz fel, 
hogy a legnagyobb tartalom is látható legyen. 
 
FELADATOK: 
1. Jelenítsük meg egy szöveget különböző elforgatással (45 fokonként) – 
D:\ECDL\modul3\formazas1.xls 
2. Készítsünk sakktábla-mintát (kijelöléskor használjuk a Ctrl billentyűt). Alakítsuk át a 
cellákat egységesen úgy, hogy négyzeteket alkossanak (a cellákat módosítva 
függőlegesen és vízszintesen is, legyenek 60x60 pixelesek). Írjunk az oszlopok előtti 
cellákba betűket, a sorok előttibe pedig számokat, amelyeket középre igazítunk 
függőlegesen és vízszintesen is. 
D:\ECDL\modul3\formazas2.xls 
3. Vigyünk be egy cellába egy hosszabb szöveget (nevünk, lakhelyünk, nemünk, 
szemünk színe). Másoljuk le ezt a szöveget négyszer. Az elsőre a Sortörés több sorba 
(Wrap text), a másodikra a Lekicsinyítve, hogy beleférjen (Shrink to fit), a harmadikra 
pedig a Cellák egyesítésével (Merge cells) utasítást alkalmazzuk. A negyedik lemásolt 
celláknál módosítsuk úgy a cellahatárokat, hogy az egész tartalom látható legyen. 
D:\ECDL\modul3\formazas3.xls 
4. Készítsünk iskolai órarendet az Excelben (cím 14-es félkövér Arial, szöveg 12-es 
Arial) a megfelelő cellák egyesítésével, színezésével és átméretezésével.  
D:\ECDL\modul3\formazas4.xls 
5. Mentsük el az órarendet xls, xlt és html fájlba, nyissuk meg ezeket a fájlokat 
6. Nyissuk meg az órarendünket, másoljuk a második munkalap fülre. Az eredeti táblázat 
címéhez írjuk hozzá a tavalyi évszámot, az újhoz pedig az ideit. Szúrjunk be két új sort 
(7. és 8. óra) az idei táblázatba. Az idei táblázat fülét nevezzük aktuális-ra és színezzük 
zöldre, a tavalyi órarend fülét, pedig színezzük szürkére. Az aktuális fület húzzuk az első 
helyre. 
D:\ECDL\modul3\formazas4.xls 
7. Engedélyezzük fekvő laptájolást, A4-es papírméretet, 3 cm-es margókat az oldal felső 
részére, 2 cm-es margókat az oldal többi részére 
D:\ECDL\modul3\formazas4.xls 
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Műveletek az Excelben 

 
Az Excel nem csak csak adatok tárolására, hanem műveletek elvégzésére is 

alkalmas. Az egyenlő "=" vagy a plusz "+" jellel kezdődő beírásokat kiszámítja.  
Az =45*9+789 vagy a +45*9+789 beírásának 1194 lesz az eredménye A cellában 

csak az eredmény jelenik meg, azonban ha a cella aktív, akkor a szerkesztőlécben a cella 
valódi tartalmát megjelenik. A műveletet azon cella kijelölésével kezdjük, ahová a 
művelet eredményét szeretnénk megjeleníteni. 
 
13. kép 
45*9+789 művelet eredményének megjelenítése a B1-es cellában 
 

 
 

A számtani alapműveletek (például összeadás, kivonás, szorzás, osztás) 
végrehajtásához, számok kombinálásához és az eredmények előállításához az alábbi 
matematikai jeleket használhatjuk:  
 
1. táblázat 
a számtani alapműveletek jelölése az Excelben 
 

művelet a jelölés neve  karakter 
összeadás (pluszjel) + 
kivonás vagy ellentett képzése (mínuszjel) – 
szorzás (csillag) * 
osztás (törtjel) / 
százalék (százalékjel) % 
hatványozás (pl. 3^2 - három a négyzeten) (kalap) ^ 

 
Ha egyetlen képletben több műveleti jelet vagy operátort adunk meg, az Excel a 

műveleteket a következő sorrendben hajtja végre: hatványozás, szorzás és osztás, 
összeadás és kivonás. A képlet azonos prioritású műveleteit (például szorzás és osztás) az 
Excel balról jobbra haladva értékeli ki.  

A végrehajtási sorrend módosításához az elsőnek kiértékelni kívánt képletrészt 
írjuk zárójelek közé. Például a =5+2*3 eredménye 11 lesz, mivel az Excel a szorzást az 
összeadás előtt hajtja végre. A képlet összeszorozza a 2-t a 3-mal, majd hozzáad 5-öt.  

Ha viszont a képletet módosítva zárójeleket használunk =(5+2)*3, akkor az Excel 
összeadja az 5-öt és a 2-t, majd az eredményt megszorozza 3-mal, amelynek a 
végeredménye 21.  

Legtöbbször a szerkesztőlécbe nem konkrét számokat, hanem cellahivatkozásokat 
írunk, amelyek a cellákban található számokat takarják. 



 

 
14. kép 
45*9+789 végrehajtása cellahivatkozásokkal 
 

 
 
FELADATOK: 
1. Próbáljuk ki az egyes műveleteket 
2. Jelenítsük meg a 5+2*3 B2-es, valamint a (5+2)*3 eredményét a D2-es a cellába 
D:\ECDL\modul3\muveletek1.xls 
3. A C3-as cellában jelenítsük meg a 45*9+789 művelet eredményét 
D:\ECDL\modul3\muveletek1.xls 
4. Oldjuk meg a fenti műveletet cellahivatkozások segítségével 
D:\ECDL\modul3\muveletek2.xls 
5. Készítsünk egy olyan táblázatot, amely kiszámítja az otthoni költségeinket, a bevételeket és a 
kiadásokat külön oszlopba, majd a végén adjuk össze az  oszlopokat, vonjuk ki a kiadásokat a 
bevételekből, majd a megkapott összeget fejezzük ki euróban. Bevételek: fizetés1: 30000, fizetés2 
25000, útiköltség1: 4000,  útiköltség2: 7800; Kiadások, fűtés: 2500, áram: 3200, telefon: 1200, 
élelmiszer: 9200, egyéb: 7600. Jelenítsünk meg vesszőt az ezres csoportok elválasztására, két tizedes 
számot, és a cellák formázásánál válasszuk a megfelelő pénznemeket, 
D:\ECDL\modul3\muveletek3.xls 
6. Készítsünk egy almaszedésről táblázatot (16 dátum, 4 csoport). Fejezzük ki ezután az egyes sorok, és 
oszlopok eredményeit (mennyi almát szedett le egy csoport, mennyi almát szedtek le egy napon). 
Ezután számoljuk ki, hogy mennyi almát szedtek le összesen, és mennyi maradt a fákon (becsült 
mennyiség). Végül számítsuk ki a leszedett almák (értékét-árát). Formázzuk és színezzük a táblázatot 
és mentsük el. 
D:\ECDL\modul3\muveletek4.xls 
7. Írjunk egy képletet a B2-es cellába, amely kiszámítja egy négyzet területét. Ezután írjunk egy 
képletet a C2-es cellába, amely kiszámítja egy négyzet kerületét (a négyzet oldalának hossza az A2-es 
cellába kerül). Formázzuk és színezzük a táblázatot, tüntessük fel az oszlopok megnevezéseit. 
D:\ECDL\modul3\muveletek5.xls 
8. Írjunk egy képletet a C2-as cellába, amely kiszámolja egy téglalap területét. Ezután írjunk egy 
képletet a D2-es cellába, amely kiszámítja a téglalap kerületét (a téglalap a oldalának hossza az A2-es 
cellába, a b oldala pedig a B2-es  kerül). Formázzuk és színezzük a táblázatot, tüntessük fel az oszlopok 
megnevezéseit. 
D:\ECDL\modul3\muveletek6.xls 
9. Írjunk képleteket a B2-es és a C2-es cellába, hogy annak a körnek kerületét és területét számítsa ki, 
amelyiknek sugarát az A2-es cellába írjuk! A kör kerülete: 2*pi*r, területe: pi*r^2 ahol a pi=3,14. 
Formázzuk és színezzük a táblázatot, tüntessük fel az oszlopok megnevezéseit. 
D:\ECDL\modul3\muveletek7.xls 
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Képletek másolása (Autokitöltés) 

 
Táblázatkezelő használatakor gyakran előfordul, hogy a táblázat valamelyik oszlopát vagy sorát 

hasonló módon számítjuk ki. 
 

15. kép 
Egy osztály hiányzásai 

 

 
 
Az Autokitöltés a gyakorlatban egy osztály hiányzásainak a kiszámításánál tudjuk alkalmazni. Az 

eddig tanultak alapján ki tudnánk számolni az összmennyiségeket (Össz-hó, Össz-név), úgy hogy 
egyenként összeadnánk a megfelelő cellák tartalmait. Észrevehetjük, hogy a következő sor-oszlop 
képlete nagyon hasonló, csak a cellák sorszámai változnak. Egy nagyobb kiterjedésű táblázat esetében 
ez igen fáradságos munka lehetne a sorokat és az oszlopokat alkotó cellákat külön-külön összeadni. Az 
Autokitöltés (Autofill) funkció ezt a munkát egyszerűsíti le. 

Klikkeljünk a helyesen kiszámított cellára, ilyenkor a cella jobb alsó sarkában láthatunk egy kis 
fekete négyzetet (kitöltőnégyzet). 
 
16. kép 
A kitöltőnégyzet 
 

 
 

Ha erre vezetjük az egér mutatóját, megjelenik egy fekete kereszt . Az egér bal gombját 
lenyomva tartva a megfelelő cellák irányába mozgatjuk (ahol a képletet szeretnénk alkalmazni) Excel a 
megfelelő képletet fogja létrehozni ezekben a sorokban-oszlopokban. A program a cellahivatkozást 
tartalmazó képletet lefelé úgy másolja, hogy növeli eggyel a cellahivatkozásban a sorszámot. Fölfelé 
csökkenti eggyel. Jobbra történő másolásnál az oszlopazonosítót növeli, ha balra másolunk, akkor 
csökkenti azt.  

Ha egy cella cellahivatkozásokat és állandót (egy számot) is tartalmaz, akkor a képlet 
másolásakor az állandó nem változik. Például, ha egy cella tartalma =C1*D2+5, akkor ezt lefelé 
másolva alatta =C2*D3+5 kapunk.  
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FELADATOK: 
1. Jelenítsünk meg az 1-től 50-ig terjedő számokat autokitöltés segítségével 
D:\ECDL\modul3\autokitoltes1.xls 
2. Jelenítsük meg 1-től 50-ig a páros számokat autokitöltés segítségével 
D:\ECDL\modul3\autokitoltes1.xls 
3. Jelenítsük meg 1-től 50-ig a páratlan számokat autokitöltés segítségével 
D:\ECDL\modul3\autokitoltes1.xls 
4. Jelenítsük meg 1-től 50-ig a tizes számokat autokitöltés segítségével 
5. Jelenítsünk meg egy ismétlődő sort ötször autokitöltés segítségével (fiú-lány) 
D:\ECDL\modul3\autokitoltes1.xls 
6. Jelenítsük meg a 12 hónap neveit autokitöltés segítségével 
D:\ECDL\modul3\autokitoltes1.xls 
7. Hozzuk létre a létre a táblázatot, amely egy iskolai osztály hiányzásait tartalmazza. A nevek listáját 
hozzuk létre autokitöltés segítségével. 
D:\ECDL\modul3\autokitoltes2.xls 
8. Adjuk össze a tagokat egyenként (pl. D2+D3+D4+D5....), ezután alkalmazzuk a többi cellára az 
Autokitöltés funkciót. 
D:\ECDL\modul3\autokitoltes2.xls 
9. A nevek oszlopa elé szúrjunk be egy új oszlopot, és jelenítsük meg az egyes tagok sorszámát 
autokitöltés segítségével.Egyesítsük és színezzük a megfelelő színnel. A cellahatárok legyenek piros 
szaggatott, a táblázat körvonala pedig fekete 3-as vonal.Mentsük el a változásokat.  
D:\ECDL\modul3\autokitoltes2.xls 
 
 

Relatív és abszolút cellahivatkozások 
 

Készítsünk táblázatot egy iskolai büfé forgalmáról, amelyben meghatározott termékek, az áruk és 
az elfogyott mennyiség kap helyet.  

 
17. kép 
Az iskolai büfé táblázata a bevitt adatokkal 
 

 
 

Amikor elkészültünk a táblázattal, akkor számítsuk ki (az Autokitöltést is használva) a sorok és 
az oszlopok összegét. Ezzel a művelettel megkapjuk azt, hogy naponta mennyi termék fogyott 
összesen, egy termékből mennyi fogyott a hét folyamán és azt hogy a hét folyamán összesen mennyi 
termék fogyott. 
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18. kép 
Az iskolai büfé táblázata a kiszámított mennyiségekkel 
 

 
 

Ezután számítsuk ki azt, hogy egy nap és a héten mekkora bevételre tett szert a büfé 
(összeszorozzuk az árat az elfogyott mennyiséggel minden terméknél és összeadjuk az eredményeket). 
Ha ezt a képletet jobbra másoljuk, hibás eredményeket kapunk. Az első szorzatot: jobbra másolva ezt a 
képletet a B3*C3 helyett C3*D3-at kapunk. Összeszoroztuk a hétfőn és kedden eladott zsömlék 
számát. Nekünk az lenne a jó, ha a képlet másolása az “Ár” oszlopra mutató hivatkozásokat nem 
módosítaná. Ezt a hibát az abszolút cellahivatkozásokkal tudjuk kiküszöbölni. Abszolút hivatkozás az, 
ha az oszlop- és sorazonosító elé egy $ jelet (dollár) írunk. Például: $C$3. Ez a hivatkozás ugyanúgy a 
C3-as cellára mutat, ám ha így szerepel a képletekben, akkor másoláskor nem változik. Ha a C 
oszlopban találhatóak az árak, a D oszlopban pedig a hétfőn megvásárolt cikkek, akkor a következő 
lesz a hétfői nap bevételének a képlete: =$C$3*D3+$C$4*D4+$C$5*D5+$C$6*D6+$C$7*D7.  
 
Az Excelben a következő hivatkozásokat különböztetünk meg: 
 
=A1 (relatív hivatkozás) 
=$A1 (vegyes hivatkozás, az A oszlop rögzített) 
=A$1 (vegyes hivatkozás, az első sor rögzített) 
=$A$1 (abszolút hivatkozás, azaz rögzített cella) 
 

Jelöljük ki a kiszámított értékeket és a Tizedeshelyek növelése (Increase Decimal) és a 
Tizedeshelyek csökkentése (Decrease Decimal) kapcsolókkal állítsuk be, hogy két tizedesjegy legyen 
a cellákban. Így a cellák dinár és para értékeket mutatnak. Így a heti összbevétel 8217 dinár és 80 para 

lesz. A tizedeshelyek beállítását a következő ikonokkal tudjuk beállítani:  
 
19. kép 
Az iskolai büfé táblázata a bevitt és kiszámított adatokkal 
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FELADATOK: 
1. Tüntessünk fel tetszőleges bevételeket az A2:A10 tartományba, vigyük be az euro jelenlegi 
árfolyamát a D1-es cellába. Az A2:A10 tartományban jelenítsük meg az összes érték megfelelőjét 
euróban, alkalmazva a megfelelő jellegű hivatkozást. Formázzuk az egyes cellákat a pénznemnek 
megfelelően. 
D:\ECDL\modul3\relesabszhivatkozasok1.xls 
2. Készítsük el egy jegypénztár forgalmát 
D:\ECDL\modul3\relesabszhivatkozasok2.xls 
3. Hozzuk létre és töltsük fel az iskolai büfé forgalmát kimutató táblázatot. Számoljuk ki a megfelelő 
sorok és oszlopok összegét. Abszolút hivatkozások segítségével számoljuk ki az egyes napok 
bevételeit. Számoljuk ki a napi és a heti bevételt dinárban. Határozzuk meg a napi és a heti bevételt 
euróban. Mentsük el a változásokat. 
D:\ECDL\modul3\relesabszhivatkozasok3.xls 
7. Készítsünk szorzótáblát (10-ig), alkalmazzunk vegyes hivatkozásokat 
D:\ECDL\modul3\relesabszhivatkozasok4.xls 
 
 

Függvények alkalmazása 
 

A függvények olyan előre meghatározott képletek, amelyek argumentumnak nevezett különleges 
értékek használatával számításokat hajtanak végre. A függvények segítségével egyszerű vagy összetett 
számításokat végezhetünk. Például a =SZUM(A10:A15) függvény egyenértékű az 
=A10+A11+A12+A13+A14+A15 képlettel. Ebben a példában SZUM a függvény neve, az A10:A15 az 
argumentum. Az argumentumot mindig zárójel fogja közre. Van olyan függvény is, amelynek nincs 
argumentuma, a zárójeleket ilyenkor sem hagyhatjuk el. Például a π(pi) számot (kb. 3,14) az Excel 
nagyobb pontossággal is meg tudja jeleníteni a következő függvény segítségével: =PI().  
 
Leggyakrabban gyakran használt függvények 
 
1. SZUM (SUM) - Összeadja az argumentumlistájában lévő számokat.  
2. ÁTLAG (AVERAGE) - Az argumentumokban megadott számok átlagát (számtani közepét) adja 
meg.  
3. MAX (MAX) - Az argumentumai között szereplő legnagyobb számot adja meg.  
4. MIN (MIN) - Az argumentumai között szereplő legkisebb számot adja meg.  

 
Készítsünk egy olyan táblázatot, amely segítségével begyakorolhatjuk a négy függvény 

használatát! 
 

Készítsünk egy táblázatot egy osztály osztályzatairól! 
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20. kép 
Egy osztály érdemjegyei 
 

 
 

A következő oszlopban kiszámíthatjuk az Excel segítségével egy tantárgy összpontját (az 
osztályzatok összegét).  

Klikkeljünk a Név1 elnevezésű sor következő üres cellájára. Ide kerül majd az első tanuló 
osztályzatainak összege. 

A kijelölés után válasszuk a Beszúrás menü Függvény (Insert > Function) parancsát (vagy a 
szerkesztőléc mellett található fx gombot). Az ezután megjelenő panelről válasszuk ki a SZUM (SUM) 
függvényt, amely (amint a róla szóló leírás is elárulja) összeadja a kijelölt tartományba megtalálható 
számokat.  
 
21. kép 
A Függvény beszúrása panel 
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A függvény nevének kiválasztása után a függvényargumentumokat kell meghatározni. Az Excel 
által felkínált lehetőségek általában megfelelőek, azonban ezeket ellenőriznünk kell, majd a Kész (OK) 
gombra klikkelve engedélyezzük a függvény kiszámítását. Ha a felkínált érték nem megfelelő, akkor 
ezt törölni kell, majd a  gombra kattintva meghatározhatjuk a helyes argumentumot. Segítségként a 
mező mellett szerepelnek a cellákban található értékek, a várható eredmény és a függvény leírása. Az 
első cella kiszámítása után alkalmazni tudjuk az Autokitöltés műveletet. 
 
22. kép 
A függvényargumentumok meghatározása 
 

 
 
A tantárgyátlag kiszámítása is hasonló módon történik, csak itt az ÁTLAG (AVERAGE) 

függvényt kell választanunk. A tanuló átlagának kiszámítása a tantárgyak osztályzatainak átlagából áll 
össze.  

Az osztályátlag a tanulók egyéni átlagára alkalmazott ÁTLAG függvény.  
A legmagasabb átlagot a MAX függvény alkalmazásával (a tanulók átlaga oszlopra) kapjuk meg.  
A legalacsonyabb osztályzatot pedig a MIN függvény alkalmazásával kapjuk meg. A függvény 

argumentuma pedig az a mező lesz, ahova az összes osztályzatot beírtuk. 
 
23. kép 
A végleges táblázat 
 

 
 



 22 

 Az összeadás az egyik leggyakrabban alkalmazott művelet, ezért a szokásos eszköztáron is 
helyet kapott az AutoSzum (AutoSum)  ikon formájában. Az ikon lefelé mutató nyíl részére 
mutatva másik gyakran alkalmazott függvényt (átlag, maximum, minimum) tudunk választani. Itt 
találjuk meg a Darabszám (Count) függvényt is, amely segítségével a bejelölt cellák számát tudjuk 
megjeleníteni. 
 A terjedelmes táblázatok esetében, az olvashatóságot megkönnyítve alkalmazzuk az egyes 
sorokra vagy oszlopokra az Ablaktábla rögzítése (Freeze Panes) parancsot. A rögzített rész határát 
egy függőleges vonal jelzni, amelyet az Ablaktábla feloldása (Unfreeze Panes) paranccal oldunk fel. 
 Előfordulhat, hogy egyes sorokat vagy oszlopokat szeretnénk elrejteni a táblázatból. Ezt az 
opciót a sor vagy az oszlop kijelölése után a helyi menüből a Hide (Elrejtés) parancsra klikkelve érjük 
el. Az elrejtett cellák cellaértéke továbbra is megmarad, illetve ha függvénybe van foglalva, akkor 
továbbra is elérhető lesz. Ezt az opciót a Felfedés (Unhide) paranccsal szüntetjük meg, amelyet szintén 
a helyi menüből érünk el. 
 
FELADATOK: 
1. Készítsünk el egy táblázatot, amelyben feltüntetjük egy iskolai osztály érdemjegyeit. Számoljuk ki a 
tantárgyak átlagát, a tanulók osztályzatainak összegét, a tanulók átlagát, az osztály átlagát, a 
legmagasabb átlagot és a legalacsonyabb osztályzatot. Rögzítsük (freeze) a táblázat első oszlopát, 
amelyben a neveket tüntettük fel. Mentsük el a változásokat. 
D:\ECDL\modul3\fuggvenyek1.xls 
2. Tüntessük el azokat az oszlopokat, amelyekben az osztályzatok találhatóak. 
D:\ECDL\modul3\fuggvenyek1.xls 
3. A cellahatárok módosítása nélkül, hozzuk a táblázatot olyan alakba, hogy ráférjen egy A4-es lapra  
D:\ECDL\modul3\fuggvenyek1.xls 
4. Számítsuk ki az almaszedés táblázatában az egyes napok, és egyes csoportok átlagát, majd a 
csoportok legalacsonyabb, és legmagasabb teljesítményét 
D:\ECDL\modul3\muveletek4.xls 
 
Logikai (Logical) függvények 
 

A HA (IF) függvényt gyakran használjuk feladatokban, ezzel a függvénnyel feltételes 
vizsgálatok hajthatók végre értékeken és képleteken. Más értéket ad vissza, ha a megadott feltétel 
kiértékelésének eredménye IGAZ, s mást ha a kiértékelés eredménye HAMIS.  

A HA függvénynek három argumentuma van. Az első a Logikai_vizsgálat (Logical_test) ide 
írjuk a feltételt, amelyben megtalálható egy logikai operátor (például: A1>30). A következő 
argumentum az Érték_ha_igaz (Value_if_true) a beírt szöveg (vagy más) akkor jelenik meg a 
cellában, ha a feltétel igaz. A harmadik argumentum Érték_ha_hamis (Value_if_false), amely akkor 
jelenik meg, ha a feltétel hamis.  

 
Az Excelben a következő összehasonlító operátorokat használhatjuk: 
 

= egyenlőségjel  
> nagyobb, mint jel  
< kisebb, mint jel 
>= nagyobb vagy egyenlő jel  
<= kisebb vagy egyenlő jel  
<> nem egyenlő jel  
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24. kép 
A HA függvény argumentumainak beállítása 
 

 
 
 
FELADATOK: 
1. Készítsünk egy táblázatot, amelyben egy elképzelt felvételi pontszámai jelennek meg. Ha a 
pontszám 50 pontnál magasabb, akkor a „Felvételt nyert”, ha pedig alacsonyabb, akkor a „Nem nyert 
felvételt” üzenet jelenik meg. A dokumentum fejlécében jelenítsük meg a „Felvételi” szövegetl 
valamint a fájl nevét, a lábjegyzetben pedig a dátumot és időt. 
D:\ECDL\modul3\fuggvenyek2.xls 
2. Jelenítsük meg a büfé forgalma táblázatban a „magas bevétel” feliratot ha a bevétel nagyobb 1500-
nál, és az „alacsony bevételt”, ha a bevétel kisebb 1500-nál. Mentsük el a változásokat. 
D:\ECDL\modul3\relesabszhivatkozasok3.xls 
 
Egyéb függvények 
 
 A DARAB (COUNT) függvény eredményét az adja meg, hogy hány szám található a 
függvényargumentumba. 

A DARABTELI (COUNT IF) függvény eredményét az adja meg, hogy hány szám található a 
függvény argumentumába, amely megfelel a meghatározott kritáriumnak. 
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25. kép 
A függvény argumentumainak a meghatározása 

 

 
 
A FKERES (VLOOKUP) függvény egy tömb bal szélső oszlopában keres egy megadott 

értéket, és az így kapott sorból veszi az oszlop_szám argumentummal kijelölt cellát, és ennek tartalmát 
adja eredményül. A függvény gyakorlati felhasználásában segédtáblázatok segítségével, 
automatikusan, bírálható el egy adott érték. 
 
26. kép 
A FKERES függvény  argumentumainak beállítása 
 

 
 
A Keresési_érték (Lookup_value) mezőben arra a cellára kell hivatkoznunk, amelyből az 

eredmény következik (keresendő érték) 
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Tábla (Table_array) az a rész, amelyben a keresést végre kell hajtani. 
Oszlop_szám (Col_index_num) a tábla azon oszlopa, amelyből az eredményt meg kívánjuk 

jeleníteni. 
 

27. kép 
A táblázat egy része 
 

 
 
 A fenti képen egy táblázat részlete látható, amely az összegyűjtött pontokat figyelembe véve 
határozza meg az osztályzatot. Ebben az esetben a Pontszám oszlop első cellája (22) lesz a Keresési 
érték. A Tábla ebben az esetben a sárga segédtáblázat lesz. Az Oszlop szám értéke az Osztályzatok 
azon részén, amelynél az osztályzatokat számokkal fejeztük ki 2, a következő oszlopban pedig 3 lesz.   
 
FELADATOK: 
1. Készítsünk egy táblázatot, amely összeadja 5 feladat pontszámát, egy másik táblázat szerint 
kiszámolja az érdemjegyet és emellett a megfelelő szót is megjeleníti (pl: jeles). 
D:\ECDL\modul3\fuggvenyek3.xls 
2. Függvény segítségével jelenítsük meg azt, hogy az aktuális héten hány árúcikk került eladásra. 
D:\ECDL\modul3\relesabszhivatkozasok3.xls 
3. Függvény segítségével jelenítsük meg az osztályzatok táblázatból az egyesek, a kettesek, a 
hármasok, a négyesek és az ötösök számát. 
D:\ECDL\modul3\fuggvenyek1.xls 
4. Módosítsuk az átlagszámítást úgy, hogy 1 legyen az átlag, ha az osztályzatok között szerepel egyes 
D:\ECDL\modul3\fuggvenyek1.xls 
5. Tetszőleges számsorok segítségével jelenítsük meg az összes megismert függvényfunkciót 
D:\ECDL\modul3\fuggvenyek4.xls 
 

 
 
 
 
 
 
 
 
 
 



 26 

 
 

Pénznem, Százalék és Dátum 
 

A pénzem, százalék és a dátum beállítását a cellák formázásánál határozhatjuk meg, vagy pedig 
a szokásos eszköztár ikonjára klikkelve állíthatjuk be. 
 
Pénznem(Currency Style)  
 
 Bekapcsolásával a szám elé dollárjelet jelenít meg a szoftver, és két tizedesszám megjelenítését 
kapcsol be.  
 
Százalékszámítás (Percent Style)  

 
Ha a százalékformátumot választjuk a szokásos eszköztárról vagy a Cellák formázása panelen a 

Szám mezőben, akkor az Excel  a számot megszorozza 100-zal, a megjelenő érték után a % jelet teszi, 
a tizedesjegyek számát pedig 0-ra állítja. Ezután a szerkesztőlécben is százalék jelenik meg, de a szám 
valódi értéke továbbra is 100-szor kisebb lesz. 
 Ha egy cellába százalékértéket írunk (pl.: 25%), akkor a program bekapcsolja a 
százalékformátumot, de a cella értéke 0.25 marad itt is. 
 Százalékszámítást úgy tudunk elérni, ha összeszorozzuk a százalékot és az értéket tartalmazó 
mezőt. 
 
28. kép 
A százalékszámítás megvalósulása 
 

 
 

 Azt, hogy egy szám a másik számnak hány százaléka azt úgy kapjuk meg, ha elosztjuk őket, 
ezután az eredmény cellájában a százalékformátumot kapcsoljuk be. A megjelenő eredménynél az 
osztott szám lesz az osztó százaléka. 
 
29. kép 
A százalékszámítás megvalósulása 
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FELADATOK: 
1. A B3-as cellába számítsuk ki azt, hogy hány nap telt el 1900. január 1. óta. 
D:\ECDL\modul3\datum1.xls 
2. A C1-es cellába vigyük be saját születési dátumunkat. Számítsuk ki a B4-es cellába azt, hogy hány 
nap telt el a születésünktől (vonjuk ki a mai dátumból a születésünk dátumát – a cellára, amelybe az 
eredmény kapjuk, alkalmazzunk Általános formázást). A következő cellába jelenítsük meg az 
életkorunkat években (a napokat osszuk el 365-tel) 
D:\ECDL\modul3\datum1.xls 
3. Készítsünk táblázatot egy konferencia előadóiről, amelyben helyet kap az érkezés ideje, a távozás 
ideje, és ennek függvényében az előadó napidíja. A táblázat alá jelenítsük meg a mai dátumot, a 
konferencia kezdetének a dátumát, és azt hogy hány nap múlva kezdődik a konferencia. 
D:\ECDL\modul3\datum2.xls 
 
Dátumformátum (Date) 
 

A Microsoft Excel a dátumokat dátumértéknek nevezett sorszámként tárolja. Alapértelmezés 
szerint 1900. január 1. megfelelője az 1-es sorszám, míg például a 2007. május 3. dátumhoz a 39205 
szám tartozik, hiszen 39205 nap múlt el 1900. január 1. után. 

Az Excel a nap kisebb részeit (óra, perc, másodperc) tizedes törtként tárolja, mivel ezt a nap 
részének tekinti. 

Láthatjuk, hogy a dátumok és ezek alkotóelemei matematikai értékek, amelyeket 
összeadhatunk, kivonhatunk, illetve egyéb számításokba is elvégezhetünk segítségükkel.  
 A függvényeknél egy kategória vonatkozik a dátum és idő függvényeire. A leggyakrabban 
használt a =MA (), amelyet az angol nyelvű szoftverben =NOW () utasítással jelöl a szoftver. Ha angol 
nyelvű szoftvert használunk, akkor gondot okozhat a magyar írásmódnak megfelelő dátum 
megjelenítése, illetve átalakítása. Ilyenkor használjuk az amerikai dátumjelölést (hónap/nap/év - 
5/3/2007). 
 
FELADATOK: 
1. Készítsük el a táblázatot, amely a tankönyvek árát számolja ki, ha 10 darab esetén 1.5, 30 darab 
esetén 2.8 százalékos kedvezményt kapunk a kiadótól. 
D:\ECDL\modul3\szazalek1.xls 
2. Készítsünk táblázatot, amely az iskolai büfé készletét tartja számon és kiszámítja, hogy egyes 
termékek hány százaléka fogyott el.  
D:\ECDL\modul3\szazalek2.xls 
3. Készítsünk egy táblázatot, amely összeadja az egyes bevételeket négy hónapra, kifejezi a bevételek 
százalékos arányát (alkalmazzunk vegyes hivtkozást és másoljuk az egész oszlop képletét). Jelenítsük 
meg, hogy hány hónapot számoltunk, valamint vessük össze a kapott eredményt az előző négy 
hónappal, és elbírálja el a program, hogy van-e bevételnövekedés 
D:\ECDL\modul3\szazalek3.xls 
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Adatok rendezése  
 

A szokásos eszköztár tartalmaz két ikont, amelyekkel rendezhetjük adatainkat, de ezeket csak 
akkor használjuk, ha egy oszlop tartalmát akarjuk rendezni. Az adatokat rendezhetjük Csökkenő (Sort 
Ascending) és Növekvő (Sort Descending) sorrendbe.  

Táblázatos adatok rendezéséhez jelöljük ki adatainkat és válasszuk az Adatok menüpont Sorba 
rendezés parancsát (Data > Sort). Itt meghatározhatjuk azt, hogy milyen szempontok szerint rendezze 
a program a kiválasztott adatainkat. Ha több szempont szeretnénk rendezni, akkor meg kell határozni, 
hogy melyik az első, a második, esetleg a harmadik rendezési szempont.  

Az Egyebek (Options) panel alatt további beállításokat tudunk meghatározni. 
Meghatározhatjuk a rendezés irányát (felülről lefelé vagy jobbról balra) vagy a rendezést kis- és 
nagybetűk szerint. 

 
30. kép 
Adatok rendezésének a szempontjai 

 

 
 
 
FELADATOK: 
1. Vegyünk fel tetszőleges számokat egy oszlop celláiba. Másoljuk az oszlop celláit a két következő 
oszlopba. Ezután rendezzük a második oszlopot növekvő, a harmadikat pedig csökkenő sorrendbe az 
Eszköztáron található ikonnal 
D:\ECDL\modul3\rendezes1.xls 
2. Készítsünk egy tetszőleges osztály érdemjegyeiből álló táblázatot. Másoljuk le ezt a táblázatot 
kétszer. Az első lemásolt táblázatot rendezzük nevek ABC sorrend szerint, a másodikat pedig az 
osztályzatok szerint 
D:\ECDL\modul3\rendezes2.xls 
3. Készítsünk táblázatot egy évfolyam hallgatóiról. Az oszlopokba a nevek mellé a vizsga érdemjegye, 
a szeminárium érdemjegye, és a kollokvium eredménye kerül. Másoljuk ezt a táblázatot az első alá. A 
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második táblázatban az adatokat rendezzük csökkenő sorrendben a következő szempontok alapján 
(vizsga, kollokvium, szeminárium) 
D:\ECDL\modul3\rendezes3.xls 
 

Diagramok  
 

 A diagramokkal grafikus módon ábrázolhatjuk adatainkat, ezzel szemléletesebbé téve azokat. 
Legegyszerűbben a Diagramvarázsló (Chart Wizard) segítségével készíthetünk diagramokat, 
előzőleg kijelölve azokat a cellákat, amelyek alapján felépül a diagramunk. 
 A diagram készítésének első lépése a megfelelő cellatartományok kijelölése (nem összefüggő 
cellák kijelölésénél használjuk a Ctrl billentyűt). 
 Ezután indítsuk el a Diagramvarázslót. A diagramvarázsló első ablakában Diagramtípusok 
(Chart Type) és azon belül Altípusok (Chart sub-type) közül választhatunk. A Minta 
megtekintéséhez tartsa lenyomva (Press and Hold to View Sample) gombra kattintva a leendő 
diagramunk az Altípusok helyén jelenik meg. A következő lépésre Tovább (Next) gombra klikkelve 
térünk át. 
 
31. kép 
A diagramkészítés első lépése 
 

 
 

A diagram varázsló második ablaka már mutatja a diagram mintáját és a cellatartományt 
abszolút hivatkozásként, amelyik alapján készül a diagram. Például: 
=Munka1! $D$7:$M$8. Láthatjuk, hogy a címben a munkalap neve is szerepel. Utána egy 
felkiáltójellel. A Microsoft Excelben így kell hivatkozni cellákra munkalapok között. 
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Az Adatsor (Series) módosíthatjul és nevet adhatunk a diagram adatsoraként szolgáló cellákat.  
A Back (Vissza) gombra klikkelve visszatérünk az előző lépésre, a Mégse (Cancel) gombra 

klikkelve megszakítjuk a folyamatot. 
 

32. kép 
A diagramkészítés második lépése 

 

 
 
A Diagramvarázsló harmadik lépésének paneljén hat fül található. A panelen elvégzett 

módosítások megjelennek a panel jobb oldalán látható diagramon. 
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33. kép 
A diagramkészítés harmadik lépése 
 

 
 
 A Címek (Titles) fülön az egész diagram címét, illetve az x és az y tengely elnevezését tudjuk 
meghatározni. 
 A Tengelyek (Axes) résznél a tengelyek értékeinek a megjelenítését tudjuk beállítani (akár el is 
tüntetni). 
 A Rácsvonalak (Gridlines) fülnél meghatározhatjuk a diagram rácsvonalainak fajtáit és 
megjelenítését. 
 A Jelmagyarázat (Legend) fül alatt a jelmagyarázat elhelyezését tudjuk beállítani. 

A Feliratok (Data Labels) fülön a diagramunkon szereplő szöveg beállításait tudjuk elvégezni. 
Az Adattábla (Data Table) résznél a diagramot alkotó adatokat tudjuk táblázatszerűen 

megjeleníteni, a diagram felületén. 
A diagramvarázsló negyedik ablakában választhatunk, hogy a táblázatunk munkalapján 

(Objektumként itt: - As object in:), vagy Új munkalapon (As new sheet:) jöjjön létre a diagram. 
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34. kép 
A diagramkészítés negyedik lépése 

 

 
 

A diagramot utólag is formázhatjuk, ha duplán kattintunk arra a diagramelemre (háttér, tengely, 
stb.), amelyet módosítani szeretnénk. Az utólagos formázásban módosítani tudjuk a Diagram varázsló 
segítségével beállított értékeket, meg tudjuk határozni a mezők színét, mintázatát és körvonalát. 

 
35. kép 
A digramelemek módosítása 
 

 
 

FELADATOK: 
1. Készítsünk egy olyan diagramot, amely vonal formájában jeleníti meg a Név3 hiányzásait az év 
folyamán (használjunk vastagabb piros vonalat, és jelenítsük meg az értékeket a diagramon. 
D:\ECDL\modul3\autokitoltes2.xls 
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2. Fagyasszuk le az első oszlopot. Hozzunk létre egy olyan vonaldiagramot, amely összehasonlítja a 
Név2, a Név5 és a Név9 hiányzásait. Alkalmazzunk világos kék hátteret a diagramnál, válasszunk 
vastagabb vonalvastagságot 
D:\ECDL\modul3\autokitoltes2.xls 
3. Készítsünk oszlopdiagramot a négy hónap bevételeinek az eloszlásáról, alkalmazzunk a diagram 
hátterére citromsárga színt. 
D:\ECDL\modul3\szazalek3.xls 
4. Jelenítsük meg a márciusi bevételeket kördiagram formájában, jelenítsük meg az egyes szeleteknél 
az értékeket. 
D:\ECDL\modul3\szazalek3.xls 
5. Készítsünk kördiagramot egy iskolai kirándulás költségeinek az elosztásáról, jelenítsük meg az egyes 
szeleteknél a százalékot. Alkalmazzunk az egyes szeletekre olyan mintát, amely fekete-fehér 
nyomtatásban is jól látható. 
D:\ECDL\modul3\diagram1.xls 
6. Készítsünk egy táblázatot egyes hónapok bevételéből. Fejezzük ki az összegeket forintban is. 
Számoljuk ki, hogy mennyi az egész évi bevétel, és azt hogy hány érték van 100 000 din felett. A 
segédtáblázat segítségével értékeljük az egyes hónapok bevételeit.  
D:\ECDL\modul3\diagram2.xls 
7. Számoljuk ki a forgalmi adót és a bruttó összegeket. Fejezzük ki oszlopdiagram formájában az egy 
év alatt megvalósított bevételeket, valamint a teljes összeg és a forgallmi adó arányát. 
D:\ECDL\modul3\diagram2.xls 
 
 

Dokumentumok nyomtatása 
 

 Az egyes dokumentumok kinyomtatása megegyezik a Word programban ismertetett művelettel. 
Azzal, hogy a Nyomtatási kép (Print Preview) gomb lenyomása után láthatóvá vállnak az oldal 
határai. A Nyomtatás panelen (Print) kiválasztható az, hogy mit kívánunk nyomtatni: A kijelölt 
terület (Selection), A kijelölt munkafüzetlap (Active sheet(s)), A teljes munkafüzet (Entire 
workbook).A Nyomtatás fájlba (Print to file) opció is a Word programban megismertetett módon 
működik. 
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36. kép 
nyomtatási panel 
  

 
 
FELADATOK: 
Jölöljük ki a D:\ECDL\modul3\autokitoltes2.xls dokumentumból a táblázatot. Nyomtassuk ki fájlba a 
kijelölt részt. 
 

 

 
 
 

 


